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Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
ComponentWorks™, FieldPoint™, natinst.com™, and NI-DAQ™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
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The Getting Results with ComponentWorks Autotuning PID 
manual contains the information you need to get started with the 
ComponentWorks Autotuning PID control. ComponentWorks adds 
the instrumentation-specific tools for designing control strategies 
in Visual Basic, Visual C++, Delphi, and other ActiveX control 
environments.

This manual contains step-by-step instructions for building applications 
with ComponentWorks. You can modify these sample applications to su
your needs. This manual does not show you how to use every control or 
solve every possible programming problem. Use the online reference f
further, function-specific information.

To use this manual, you already should be familiar with one of the 
supported programming environments and Windows 98/95 or 
Windows NT.

Organization of This Manual
The Getting Results with ComponentWorks Autotuning PID manual is 
organized as follows.

• Chapter 1, Introduction to ComponentWorks Autotuning PID, 
contains an overview of ComponentWorks, lists the ComponentWo
Autotuning PID system requirements, describes how to install the
software, and presents basic information about ComponentWorks
ActiveX controls.

• Chapter 2, Getting Started with ComponentWorks, describes 
approaches to help you get started using ComponentWorks 
Autotuning PID, depending on your application needs, your 
experience using ActiveX controls in your particular programming
environment, and your specific goals in using ComponentWorks.

Part I, Building ComponentWorks Applications
This section describes how to use ActiveX controls in the most commonly
used programming environments—Visual Basic, Visual C++, and Borland 
Delphi.
© National Instruments Corporation xi ComponentWorks Autotuning PID
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Part I, Building ComponentWorks Applications, contains the following 
chapters.

• Chapter 3, Building ComponentWorks Applications with Visual Basi, 
describes how you can use the ComponentWorks controls with Vis
Basic; insert the controls into the Visual Basic environment, set th
properties, and use their methods and events; and perform these 
operations using ActiveX controls in general. This chapter also 
outlines Visual Basic features that simplify working with ActiveX 
controls.

• Chapter 4, Building ComponentWorks Applications with Visual C++, 
describes how you can use ComponentWorks controls with Visua
C++, explains how to insert the controls into the Visual C++ 
environment and create the necessary wrapper classes, shows you
to create an application compatible with the ComponentWorks 
controls using the Microsoft Foundation Classes Application Wiza
(MFC AppWizard) and how to build your program using the 
ClassWizard with the controls, and discusses how to perform thes
operations using ActiveX controls in general.

• Chapter 5, Building ComponentWorks Applications with Delphi, 
describes how you can use ComponentWorks controls with Delph
insert the controls into the Delphi environment, set their properties
and use their methods and events; and perform these operations u
ActiveX controls. This chapter also outlines Delphi features that 
simplify working with ActiveX controls.

Part II, Using the ComponentWorks Autotuning PID Control
This section describes the ComponentWorks PID, LeadLag, and Ram
controls. These chapters contain overviews of the controls and their m
commonly used properties, methods, and events; short code segmen
illustrate programmatic control; and tutorials that lead you through 
building an application with the controls.

Part II, Using the ComponentWorks Autotuning PID Control, contains the 
following chapters.

• Chapter 6, Using the PID Control, describes the Autotuning PID 
control and includes a tutorial with step-by-step instructions for usi
the control. This chapter also introduces the LeadLag and Ramp 
controls.

• Chapter 7, PID Examples, describes examples included with the 
ComponentWorks Autotuning PID software.
ComponentWorks Autotuning PID xii © National Instruments Corporation
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Part III, PID Algorithms and Control Strategies
This section describes the Autotuning PID algorithms and basic contro
design systems. Part III, PID Algorithms and Control Strategies, contains 
the following chapters.

• Chapter 8, Algorithms, explains the PID algorithm, the Autotuning 
algorithm, and how these algorithms are applied to control system

• Chapter 9, Designing Control Strategies, describes how you can 
design and implement control strategies with the PID, LeadLag, a
Ramp controls.

Appendices, Glossary, and Index
• Appendix A, Error Codes, lists the error codes returned by 

ComponentWorks.

• Appendix B, Distribution and Redistributable Files, contains 
information about ComponentWorks Autotuning PID redistributable 
files and distributing applications that use ComponentWorks controls.

• Appendix C, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our produ
and manuals.

• The Glossary contains an alphabetical list and description of terms
used in this manual, including acronyms, abbreviations, metric 
prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics in this 
manual, including the page where you can find each one.

Conventions Used in This Manual
The following conventions are used in this manual:

<> Angle brackets enclose the name of a key on the keyboard—for example, 
<Shift>.

- A hyphen between two or more key names enclosed in angle brackets 
denotes that you should simultaneously press the named keys—for 
example, <Control-Alt-Delete>.

» The » symbol leads you through nested menu items and dialog box opt
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to pull down the File menu, select the Page Setup item, 
© National Instruments Corporation xiii ComponentWorks Autotuning PID
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select Options, and finally select the Substitute Fonts options from the 
last dialog box.

This icon to the left of bold italicized text denotes a note, which alerts y
to important information.

bold Bold text denotes the names of menus, menu items, parameters, and d
box options.

bold italic Bold italic text denotes a note.

<Control> Key names are capitalized.

italic Italic text denotes variables, emphasis, a cross reference, or an introdu
to a key concept.

monospace Text in this font denotes text or characters that you should literally ent
from the keyboard, sections of code, programming examples, and syn
examples. This font is also used for the proper names of disk drives, pa
directories, programs, subroutines, device names, functions, operation
properties and methods, filenames and extensions, and for statement
comments taken from programs.

paths Paths in this manual are denoted using backslashes (\) to separate d
names, directories, folders, and files.

Related Documentation
The following document contains information you might find useful as y
read this manual:

• ComponentWorks Autotuning PID Online Reference (available 
by selecting Programs»National Instruments ComponentWorks» 
Autotuning PID»ComponentWorks PID Reference from the 
Windows Start menu)

If you have purchased and installed one of the ComponentWorks 
development systems, you also have access to the following 
documentation:

• Getting Results with ComponentWorks

• ComponentWorks Online Reference (available by selecting 
Start»Programs»National Instruments ComponentWorks» 
ComponentWorks Reference)
ComponentWorks Autotuning PID xiv © National Instruments Corporation
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Customer Communication
National Instruments wants to receive your comments on our products 
and manuals. We are interested in the applications you develop with our 
products, and we want to help if you have problems with them. To make it 
easy for you to contact us, this manual contains comment and configuration 
forms for you to complete. These forms are in Appendix C, Customer 
Communication, at the end of this manual.
© National Instruments Corporation xv ComponentWorks Autotuning PID
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Introduction to 
ComponentWorks 
Autotuning PID

This chapter contains an overview of the ComponentWorks Autotunin
PID control, lists the ComponentWorks Autotuning PID system 
requirements, describes how to install the software, and presents 
introductory information about ComponentWorks ActiveX controls.

What Is ComponentWorks Autotuning PID?
ComponentWorks Autotuning PID is a collection of ActiveX controls fo
developing PID control applications within any compatible ActiveX 
control container. ActiveX controls also are known as OLE (Object 
Linking and Embedding) controls, and the two terms can be used 
interchangeably in this context. Use the online reference for specific 
information about the properties, methods, and events of the individua
ActiveX controls. You can access this information by selecting 
Programs»National Instruments ComponentWorks»Autotuning 
PID»ComponentWorks PID Reference from the Windows Start menu.

PID (Proportional-Integral-Derivative) is the most common control 
algorithm used in industry. PID is often used to control processes such
heating and cooling systems, fluid level monitoring, flow control, and 
pressure control. The system parameter being controlled is referred to
the process variable (for example, temperature, pressure, or flow rate). T
operator must specify a setpoint or desired value for the process variable
that is to be controlled. A PID controller determines a controller output 
value (for example, heater power or valve position). The controller out
value is applied to the system which in turn affects the process variable
drives it toward the setpoint value.
s Autotuning PID
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With ComponentWorks Autotuning PID, you can develop control 
applications based on proportional-integral-derivative (PID) controllers

• Proportional (P); proportional-integral (PI); proportional-derivative 
(PD); and proportional-integral-derivative (PID) algorithms

• Gain-scheduled PID

• PID autotuning

• Error-squared PID

• Lead-Lag compensation

• Setpoint ramp generation

• Multiloop cascade control

• Feedforward control

• Override (minimum/maximum selector) control

• Ratio/bias control

The ComponentWorks Autotuning PID package contains the following
components:

• PID Control—ActiveX control for implementing PID process contro
algorithms in a physical system. 

• LeadLag Control—ActiveX control for calculating the dynamic 
compensator in feedforward control schemes.

• Ramp Control—ActiveX control for generating setpoint ramps.

The ComponentWorks ActiveX controls are designed for use in 
Visual Basic, a premier ActiveX control container application. Some 
ComponentWorks features and utilities have been incorporated with th
Visual Basic user in mind. However, you can use ActiveX controls in oth
applications that support them, including Visual C++ and Delphi.

System Requirements
To use the ComponentWorks Autotuning PID ActiveX controls, your 
computer must meet the following minimum requirements:

• Personal computer using at least a 33 MHz 80486 or higher 
microprocessor (National Instruments recommends a 90 MHz 
Pentium or higher microprocessor)

• Microsoft Windows 98/95 or Windows NT version 4.0

• VGA resolution (or higher) video adapter
ComponentWorks Autotuning PID 1-2 © National Instruments Corporation
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• 32-bit ActiveX control container such as Visual Basic 4.0 or greate
Visual C++ 4.x or greater, or Delphi

• Minimum of 16 MB of memory

• Minimum of 10 MB of free hard disk space

• Microsoft-compatible mouse

Installing ComponentWorks

Note To install ComponentWorks on a Windows NT system, you must be logged in w
Administrator privileges.

1. Insert the ComponentWorks Autotuning PID CD in the CD drive 
of your computer. From the CD startup screen, click Install 
ComponentWorks Autotuning PID. If the CD startup screen does 
not appear, use the Windows Explorer to run the SETUP.EXE program 
in the \Setup  directory on the CD.

2. Follow the instructions on the screen. The installer provides differe
options for setting the directory in which ComponentWorks is install
and choosing examples for different programming environments. U
the default settings if you are unsure about which settings to choos
necessary, you can run the installer at a later time to install additio
components.

Installing From Floppy Disks
If your computer does not have a CD drive, you can copy the files to flop
disks and install the controls from those disks, as described by the 
following steps.

1. On another computer with a CD drive and disk drive, copy the files
the individual subdirectories of the \Setup\disks  directory on the 
CD onto individual 3.5" floppy disks. The floppy disks should not 
contain any directories and should be labeled disk1 , disk2 , and so 
on, following the name of the source directories.

2. On the target computer, insert the floppy labeled disk1  and run the 
setup.exe  program from the floppy.

3. Follow the on-screen instructions to complete the installation.
© National Instruments Corporation 1-3 ComponentWorks Autotuning PID
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Installed Files
The ComponentWorks setup program installs the following groups of fi
on your hard disk.

• ActiveX controls, documentation, and other associated files

Directory: \Windows\System\

Files: cwpid.ocx , cwpid.dep , cwpid.hlp , cwpid.cnt

• Example programs and applications

Directory: \ComponentWorks\Samples\...

• Tutorial programs

Directory: \ComponentWorks\Tutorials-PID\...

• Miscellaneous files

Directory: \ComponentWorks\

Note You select the location of the \ComponentWorks\...  directory during 
installation.

About the ComponentWorks Controls
This section presents background information about the ComponentW
ActiveX controls. Make sure you understand these concepts before 
continuing. You also should refer to your programming environment 
documentation for more information about using ActiveX controls in 
that environment. 

Properties, Methods, and Events
ActiveX controls consist of three different parts—properties, methods,
and events—used to implement and program the controls.

Properties are the attributes of a control. These attributes describe the 
current state of the control and affect the display and behavior of the 
control. The values of the properties are stored in variables that are pa
of the control.

Methods are functions defined as part of the control. Methods are calle
with respect to a particular control and usually have some effect on th
control itself. The operation of most methods is affected by the current
property values of the control.
ComponentWorks Autotuning PID 1-4 © National Instruments Corporation
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Events are notifications generated by a control in response to some 
particular occurrence. Events are passed to the control container 
application to execute a particular subroutine in the program (event 
handler).

Note Use the online reference for specific information about the properties, methods
and events of the ActiveX controls. You can access the online reference by 
selecting Programs»National Instruments ComponentWorks»Autotuning 
PID»ComponentWorks PID Reference from the Windows Start menu.

Object Hierarchy
The three parts of an ActiveX control—properties, methods, and 
events—are stored in a software object. Because some ActiveX controls 
are very complex and contain many properties, ActiveX controls are of
subdivided into different software objects, the sum of which make up t
ActiveX control. Each individual object in a control contains specific pa
(properties) and functionality (methods and events) of the ActiveX cont
The relationships among different objects of a control are maintained in
object hierarchy. At the top of the hierarchy is the actual control itself.

This top-level object contains its own properties, methods, and events
Some of the top-level object properties are actually references to othe
objects that define specific parts of the control. Objects below the top-le
have their own methods and properties, and their properties can be 
references to other objects. The number of objects in a hierarchy is no
limited.

Figure 1-1 shows the object hierarchy of the ComponentWorks Autotun
PID control. The PID object contains some of its own properties, such
Name and Setpoint . It also contains the Parameters  property, which is 
a separate object. The Parameters object contains individual Paramet
objects, each describing one PID parameter. Each Parameter object h
properties, such as IntegralTime  and ProportionalGain , while the 
Parameters collection object has a property Count . The Parameters 
collection object is a special type of object referred to as a collection, 
which is described in the Collection Objects section.
© National Instruments Corporation 1-5 ComponentWorks Autotuning PID
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Figure 1-1.  PID Control Object Hierarchy

Collection Objects
One object can contain several objects of the same type. For example
the PID object uses several Parameter objects, each representing one
PID parameter. The number of objects in the group of objects might no
defined and might change while the program is running (that is, you ca
add or remove parameters). To handle these groups of objects more e
an object called a collection is created.

A collection is an object that contains or stores a varying number of obj
of the same type. You can consider a collection as an array of objects.
name of a collection object is usually the plural of the name of the obje
type contained within the collection. For example, a collection of Parame
objects is referred to as Parameters. In the ComponentWorks software
terms object and collection are rarely used, only the type names Parame
and Parameters are listed.

Each collection object contains an Item  method that you can use to acces
any particular object stored in the collection. Refer to Changing Properties 
Programmatically later in this chapter for information about the Item  
method and accessing particular objects stored in the collection.

PID Control
Properties:

Autotune, Parameters

Autotune Object
Properties: NoiseLevel, 

RelayAmplitude

Parameters Collection
Property: Count

Parameter Object
Properties: IntegralTime,

ProportionalGain
ComponentWorks Autotuning PID 1-6 © National Instruments Corporation
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Setting the Properties of an ActiveX Control
You can set the properties of an ActiveX control from its property pages
from within your program.

Using Property Pages
Property pages are common throughout the Windows 98/95 and 
Windows NT interface. When you want to change the appearance or 
options of a particular object, right click the object and select Properties. 
A property page or tabbed dialog box appears with a variety of proper
that you can set for that particular object. You customize ActiveX contr
in exactly the same way. Once you place the control on a form in your
programming environment, right click the control and select Properties to 
customize the appearance and operation of the control.

Use the property pages to set the property values for each ActiveX con
while you are creating your application. The property values you selec
this point represent the state of the control at the beginning of your 
application. You can change the property values from within your progr
as shown in the next section, Changing Properties Programmatically.

In some programming environments (such as Visual Basic and Delphi
you have two different property pages. The property page common to 
programming environment is called the default property sheet; it contains 
the most basic properties of a control. 

Your programming environment assigns default values for some of the
basic properties, such as the control name and the tab order. You mus
these properties through the default property sheet.

Figure 1-2 shows the Visual Basic default property sheet for the PID 
control.
© National Instruments Corporation 1-7 ComponentWorks Autotuning PID
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Figure 1-2.  Visual Basic Default Property Sheets

The second property sheet is called the custom property page. The layout 
and functionality of the custom property pages vary for different contro
Figure 1-3 shows the custom property page for the Autotuning PID con

Figure 1-3.  ComponentWorks Custom Property Pages
ComponentWorks Autotuning PID 1-8 © National Instruments Corporation
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Changing Properties Programmatically
You also can set or read the properties of your controls programmatica
For example, you can specify the type of 
controller—proportional-integral-derivative, proportional-derivative, or
proportional—with the ControllerType  property of the PID control. 

Note The exact syntax for reading and writing property values depends on the 
programming language. Refer to the appropriate Building ComponentWorks 
Applications chapter for information about using ComponentWorks in your 
programming environment. In this discussion, code examples are written in 
Visual Basic syntax, which is similar to most implementations.

Each control you create in your program has a name (like a variable na
which you use to reference the control in your program. You can set th
value of a property on a top-level object with the following syntax.

name.property = new_value

For example, you can set the ControllerType  property using the 
following line of code, where cwpidPID  is a constant specifying the PID 
controller.

CWPID1.ControllerType = cwpidPID

To access properties of sub-objects referenced by the top-level object
the control name, followed by the name of the sub-object and the prop
name. For example, consider the following code for the PID control.

CWPID1.Autotune.ControlDesign = cwpidNormal

In the above code, Autotune  is a property of the PID control and refers t
an Autotune object. ControlDesign  is one of several Autotune 
properties.

You can retrieve the value of control properties from your program in t
same way. For example, you can print the value of the PID 
ControllerType  property.

Print CWPID1.ControllerType

You can display the setpoint of the PID control in a Visual Basic text b
with the following code.

Text1.Text = CWPID1.Setpoint
© National Instruments Corporation 1-9 ComponentWorks Autotuning PID
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Item Method
To access an object or its properties in a collection, use the Item  method 
on the collection object. For example, you can set the proportional gai
a PID control with the following code.

CWPID1.Parameters.Item(2).ProportionalGain= 10

The term CWPID1.Parameters.Item(2)  refers to the second Paramete
object in the Parameters collection of the PID object. The parameter of
Item  method is an integer representing the (one-based) index of the ob
in the collection.

Because the Item  method is the most commonly used method on a 
collection, it is referred to as the default method. Therefore, some 
programming environments do not require you to specify the .Item 

method. For example, in Visual Basic

CWPID1.Parameters(2).ProportionalGain = 10

is programmatically equivalent to

CWPID1.Parameters.Item(2).ProportionalGain= 10

Working with Control Methods
ActiveX controls and objects have their own methods, or functions, tha
you can call from your program. Methods can have parameters that a
passed to the method and return values that pass information back to
program.

Methods can have required and optional parameters in some program
environments, such as Visual Basic. You can omit these optional 
parameters if you want to use their default values. Other programming
environments require all parameters to be passed explicitly. 

Depending on your programming environment, parameters might be 
enclosed in parentheses. If the function or method is not assigned a re
variable, Visual Basic does not use parentheses to pass parameters. W
returning a value to a variable, enclose parameters in parentheses, as
following example.

output = CWPID1.NextOutput(ProcessVariable)
ComponentWorks Autotuning PID 1-10 © National Instruments Corporation
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Developing Event Handler Routines
After configuring your controls on a form, you can create event handle
routines in your program to respond to events generated by the contro
For example, the PID control has an AutotuneComplete  event that fires 
(occurs) when the autotuning process has completed.

To develop the event routine code, most programming environments 
generate a skeleton function to handle each event. For information ab
generating these function skeletons, refer to the appropriate Building 
ComponentWorks Applications chapter. For example, the Visual Basic 
environment generates the following function skeleton into which you 
insert the functions to call when the AutotuneComplete  event occurs.

Private Sub CWPID1_AutotuneComplete

(ByVal NewParameterPosition As Long)

End Sub

In most cases, the event also returns some data to the event handler th
be used in your event handler routine.

Learning the Properties, Methods, and Events
The ComponentWorks PID online reference contains detailed informat
about each control and its associated properties, methods, and events
You can open the online reference from within most programming 
environments by clicking on the Help button in the custom property pages
or you can open it from the Windows Start menu by selecting 
Programs»National Instruments ComponentWorks»Autotuning 
PID»ComponentWorks PID Reference.

Some programming environments have built-in mechanisms for detail
the available properties, methods, and events for a particular control a
sometimes include automatic links to the help file.
© National Instruments Corporation 1-11 ComponentWorks Autotuning PID
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Getting Started with 
ComponentWorks

This chapter describes approaches to help you get started using 
ComponentWorks Autotuning PID, depending on your application nee
your experience using ActiveX controls in your particular programming
environment, and your specific goals in using ComponentWorks.

Explore the ComponentWorks Documentation
The printed and online manuals contain the information necessary to l
and use the ComponentWorks controls to their full capabilities. The 
manuals are divided into different sections. Each section addresses a
specific step on the learning curve.

Use the this manual to learn how to develop simple applications. It als
contains information you can use in specific circumstances, such as 
debugging particular problems.

After you understand the operation and organization of the controls, use
ComponentWorks Autotuning PID online reference to obtain informatio
about specific features of each control.

Getting Results with ComponentWorks Autotuning PID Manual
This manual contains three different parts:

• Part I, Building ComponentWorks Applications—These chapters 
describe how to use ActiveX controls in the most commonly used 
programming environments—Visual Basic, Visual C++, and Borlan
Delphi.

If you are familiar with using ActiveX controls in these environment
you should not need to read these chapters. If you are using the con
in another environment, consult your programming environment 
documentation for information about using ActiveX controls. You ca
check the ComponentWorks Support Web site for information abo
additional environments.
s Autotuning PID
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• Part II, Using the ComponentWorks Autotuning PID Control—These 
chapters describe the ComponentWorks PID, LeadLag, and Ram
controls. These chapters contain overviews of the controls and the
most commonly used properties, methods, and events; short code
segments to illustrate programmatic control; and tutorials that lead
you through building an application with the controls.

• Part III, PID Algorithms and Control Strategies—These chapters 
describe the Autotuning PID algorithms and suggest different cont
strategies.

ComponentWorks Autotuning PID Online Reference
The ComponentWorks Autotuning PID Online Reference includes 
complete reference information for all controls—all properties, method
and events for every control—as well as the text from this manual.

To use the online reference efficiently, you should understand the mate
presented in this manual about using ComponentWorks ActiveX contr
After going through this manual and its tutorials, use the online referen
as your main source of information. Refer to it when you need specific
information about a particular feature in ComponentWorks.

Accessing the Online Reference
You can open the online reference from the Windows Start 
menu (Programs»National Instruments ComponentWorks» 
Autotuning PID»ComponentWorks PID Reference). The reference 
opens to the main contents page. From the contents page, you can br
the contents of the online reference or search for a particular topic.

Most programming environments support some type of automatic link 
the online reference (help) file from within their environment, often the
<F1> key. Try selecting the control on a form or placing the cursor in co
specific to a control and pressing <F1> to evoke the online reference.

In most environments, the property pages for the ComponentWorks 
controls include a Help button that provides information about the proper
pages.

Finding Specific Information
To find information about a particular control or feature of a control, sel
the Index tab under the Help Topics page. Enter the name of the control
property, method, or event. Control names always begin with CW 
ComponentWorks Autotuning PID 2-2 © National Instruments Corporation
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(for example, CWPID). Property, method, and event names are identical
those used in the code.

One group of objects that frequently generates questions are the Colle
objects. Search the online reference for Collections  and the Item  
method for more information. You also can find information about 
collection objects in the Collection Objects section of Chapter 1, 
Introduction to ComponentWorks Autotuning PID.

Become Familiar with the Examples Structure
The examples installed with ComponentWorks Autotuning PID softwa
show you how to use the control in applications. You can use these 
examples as a reference to become more familiar with the use of the 
controls, or you can build your application by expanding one of the 
examples.

When you install ComponentWorks, you can install examples for selec
programming environments. The examples are located in the 
\ComponentWorks\samples  directory, organized by programming 
environment (\Visual Basic , \Visual  C++, and so on), and grouped in
the PID folder under each language. Within these directories, the exam
are further subdivided by functionality. 

The online reference includes a searchable list of all the examples inclu
with ComponentWorks Autotuning PID. Select Examples to see the list of 
examples.

Develop Your Application
Depending on your experience with your programming environment, 
ActiveX controls, and ComponentWorks, you can get started using 
ComponentWorks Autotuning PID in some of the following ways.

Are you new to your particular programming environment?

Spend some time using and programming in your development 
environment. Check the documentation that accompanies your 
programming environment for getting started information or tutorials, 
especially tutorials that describe using ActiveX controls in the 
environment. If you have specific questions, search the online 
documentation of your development environment. After becoming famil
with the programming environment, continue with the following steps.
© National Instruments Corporation 2-3 ComponentWorks Autotuning PID
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Are you new to using ActiveX controls or do you need to learn how to 
use ActiveX controls in a specific programming environment?

Make sure you have read and understand the information about Active
controls in Chapter 1, Introduction to ComponentWorks Autotuning PID, 
and the appropriate chapter about your specific programming environm
Refer to Table 2-1 to find out which chapter you should read for your 
specific programming environment.

If you use Borland C++ Builder, most of Chapter 5 pertains to you. If y
use another programming environment, see the ComponentWorks Sup
Web site (www.natinst.com/support ) for current information about 
particular environments.

Regardless of the programming environment you use, consult its 
documentation for information about using ActiveX controls. After 
becoming familiar with using ActiveX controls in your environment, 
continue with the following steps. 

Are you familiar with ActiveX controls but need to learn 
ComponentWorks controls, hierarchies, and features?

If you are familiar with using ActiveX controls, including collection 
objects and the Item  method, read the chapters pertaining to the contro
you want to use. Part II provides basic information about the PID contr
and describes its most commonly used properties, methods, and even
Chapter 6, Using the PID Control, also offers a tutorial to help you become
more familiar with using the controls. The tutorial solution is installed wi
your software (\ComponentWorks\Tutorials-PID) .

After becoming familiar with the information in these chapters, try buildin
applications with the ComponentWorks controls. You can find detailed
information about all properties, methods, and events for every contro
the online reference.

Table 2-1.  Chapters about Specific Programming Environments

Environment Read This Chapter

Microsoft Visual Basic Chapter 3, Building ComponentWorks 
Applications with Visual Basic

Microsoft Visual C++ Chapter 4, Building ComponentWorks 
Applications with Visual C++

Borland Delphi Chapter 5, Building ComponentWorks 
Applications with Delphi
ComponentWorks Autotuning PID 2-4 © National Instruments Corporation
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Do you want to develop applications quickly or modify existing 
examples?

If you are familiar with using ActiveX controls, including collections an
the Item  method, and have some experience using ComponentWorks
other National Instruments products, you can get started more quickly
looking at the examples.

Most examples demonstrate how to perform operations with a particul
control. Generally, the examples avoid presenting complex operations
more than one control. To become familiar with a control, look at the 
example for that control. Then, you can combine different programmin
concepts from the different controls in your application.

The examples include comments to provide more information about th
steps performed in the example. The examples avoid performing com
programming tasks specific to one programming environment; instead
they focus on showing you how to perform operations using the 
ComponentWorks controls. When developing applications with ActiveX
controls, you do a considerable amount of programming by setting 
properties in the property pages. Check the value of the control prope
in the examples because the values greatly affect the operation of the
example program. In some cases, the actual source code used by an 
example might not differ from other examples; however, the values of 
properties change the example significantly.

Seek Information from Additional Sources
After working with the ComponentWorks controls, you might need to 
consult other sources if you have questions. The following sources ca
provide you with more specific information.

• Getting Results with ComponentWorks Autotuning PID 
Appendices—The appendices include error descriptions and 
distribution information.

• ComponentWorks Autotuning PID Online Reference—The online 
reference includes complete reference documentation and text fro
the Getting Results with ComponentWorks Autotuning PID manual. If 
you cannot find a particular topic in the index, choose the Find tab in 
the Help Topics page and search the complete text of the online 
reference.

• ComponentWorks Support Web Site—The ComponentWorks Supp
Web site, as part of the National Instruments Support Web site 
(www.natinst.com/support ), contains support information, 
updated continually. You can find application and support notes an
© National Instruments Corporation 2-5 ComponentWorks Autotuning PID



Chapter 2 Getting Started with ComponentWorks

ng 

er 
information about using ComponentWorks in additional programmi
environments. The Web site also contains the KnowledeBase, a 
searchable database containing thousands of entries answering 
common questions related to the use of ComponentWorks and oth
National Instruments products.
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Building ComponentWorks Applications

This section describes how to use ActiveX controls in the most commo
used programming environments—Visual Basic, Visual C++, and Borla
Delphi.

If you are familiar with using ActiveX controls in these environments, 
you should not need to read these chapters. If you are using the contr
in another environment, consult your programming environment 
documentation for information about using ActiveX controls. You can 
check the ComponentWorks Support Web site for information about 
additional environments.

Part I, Building ComponentWorks Applications, contains the following 
chapters.

• Chapter 3, Building ComponentWorks Applications with Visual Basic, 
describes how you can use the ComponentWorks controls with Vis
Basic; insert the controls into the Visual Basic environment, set th
properties, and use their methods and events; and perform these 
operations using ActiveX controls in general. This chapter also 
outlines Visual Basic features that simplify working with ActiveX 
controls.

• Chapter 4, Building ComponentWorks Applications with Visual C++ , 
describes how you can use ComponentWorks controls with Visua
C++, explains how to insert the controls into the Visual C++ 
environment and create the necessary wrapper classes, shows yo
how to create an application compatible with the ComponentWork
controls using the Microsoft Foundation Classes Application Wiza
(MFC AppWizard) and how to build your program using the 
ClassWizard with the controls, and discusses how to perform thes
operations using ActiveX controls in general.
ion I-1 ComponentWorks Autotuning PID
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• Chapter 5, Building ComponentWorks Applications with Delphi, 
describes how you can use ComponentWorks controls with Delph
insert the controls into the Delphi environment, set their properties
and use their methods and events; and perform these operations u
ActiveX controls. This chapter also outlines Delphi features that 
simplify working with ActiveX controls.
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Building ComponentWorks 
Applications with Visual Basic

This chapter describes how you can use the ComponentWorks contro
with Visual Basic; insert the controls into the Visual Basic environmen
set their properties, and use their methods and events; and perform th
operations using ActiveX controls in general. This chapter also outline
Visual Basic features that simplify working with ActiveX controls.

Note The descriptions and figures in this chapter apply specifically to the Visual Basic
environment. 

Developing Visual Basic Applications
The following procedure explains how you can start developing Visua
Basic applications with ComponentWorks.

1. Select the type of application you want to build. Initially select a 
Standard EXE for your application type.

2. Design the form. A form is a window or area on the screen on which
you can place controls and indicators to create the user interface 
your program. The toolbox in Visual Basic contains all of the contro
available for developing the form.

3. After placing each control on the form, configure the properties of 
control using the default and custom property pages.

Each control on the form has associated code (event handler routi
in your Visual Basic program that automatically executes when the
user operates that control.

4. To create this code, double click the control while editing your 
application and the Visual Basic code editor opens to a default eve
handler routine.
s Autotuning PID
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Loading ComponentWorks Controls into the Toolbox
Before building an application using ComponentWorks controls, you m
add them to the Visual Basic toolbox.

1. In a new Visual Basic project, right click the toolbox and select 
Components. 

2. Place a checkmark in the box next to National Instruments CW PID.

If the ComponentWorks controls are not in the list, select the contr
files from the \Windows\System(32)  directory by pressing the 
Browse button.

If you need to use the ComponentWorks controls in several projects, cr
a new default project in Visual Basic 5 to include the controls and serv
a template.

1. Create a new Standard EXE application in the Visual Basic 
environment.

2. Add the ComponentWorks controls to the project toolbox as descri
in the preceding procedure.

3. Save the form and project in the \Template\Projects  directory 
under your Visual Basic directory.

4. Give the form and project a descriptive name, such as CWForm and 
CWProject .

After creating this default project, you have a new option, CWProject , 
that includes the ComponentWorks controls in the New Project dialog by 
default. 

Building the User Interface Using ComponentWorks
After you add the ComponentWorks controls to the Visual Basic toolb
use them to create the front panel of your application. To place the con
on the form, select the corresponding icon in the toolbox and click and d
the mouse on the form. This step creates the corresponding control. A
creating the control, you can move it using the mouse. To move a con
click and hold the mouse on the control and drag the control to the des
location. You cannot resize the PID, LeadLag, or Ramp icons after plac
them on the form. They also are not visible during run time.

Once ActiveX controls are placed on the form, you can edit their proper
using their property sheets. You can also edit the properties from within
Visual Basic program at run time.
ComponentWorks Autotuning PID 3-2 © National Instruments Corporation
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Using Property Pages
After placing a control on a Visual Basic form, configure the control by
setting its properties in the Visual Basic property pages (see Figure 3-
and ComponentWorks custom control property pages (see Figure 3-2
Visual Basic assigns some default properties, such as the control nam
and the tab order. When you create the control, you can edit these sto
properties in the Visual Basic default property sheet. To access this sh
select a control and select Properties Window from the View menu, or 
press <F4>. To edit a property, highlight the property value on the righ
side of the property sheet and type in the new value or select it from a
down menu. The most important property in the default property shee
Name, which is used to reference the control in the program.

Figure 3-1.  Visual Basic Property Pages

Edit all other properties of an ActiveX control in the custom property 
sheets. To open the custom property sheets, right click the control on 
form and select Properties or select the controls and press <Shift-F4>.
© National Instruments Corporation 3-3 ComponentWorks Autotuning PID
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Figure 3-2.  ComponentWorks Custom Property Pages in Visual Basic

Using Your Program to Edit Properties
You can set and read the properties of your controls programmatically
Visual Basic. Use the name of the control with the name of the propert
you would with any other variable in Visual Basic. The syntax for setting
property in Visual Basic is name.property  = new value .

For example, you can set the Setpoint  property of a PID control using the
following line of code, where CWPID1 is the default name of the PID 
control.

CWPID1.Setpoint = 50

To access properties of sub-objects referenced by the top-level object
the control name, followed by the name of the sub-object and the prop
name. For example, consider the following code for the PID control.

CWPID1.Parameters(1).ProportionalGain = 10

In the above code, Parameter  is a property of the PID control and refers
to a Parameter object. ProportionalGain  is one of several Parameter 
properties.

You can retrieve the value of control properties from your program in t
same way. For example, you can print the value of the PID Setpoint  
property.

Print CWPID1.Setpoint
ComponentWorks Autotuning PID 3-4 © National Instruments Corporation
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You can display the proportional gain of a parameter in a Visual Basic 
box with the following code.

Text1.Text = CWPID1.Parameters(1).ProportionalGain

Working with Control Methods
Calling the methods of an ActiveX control in Visual Basic is similar to 
working with the control properties. To call a method, add the name of 
method after the name of the control (and sub-object if applicable). Fo
example, you can call the Reset  method on the PID control.

CWPID1.Reset

Methods can have parameters that you pass to the method and return v
that pass information back to your program. In Visual Basic, if you call
method without assigning a return variable, any parameters passed to
method are listed after the method name, separated by commas witho
parentheses. If you assign the return value of a method to a return vari
enclose the parameters in parentheses.

Output = CWPID1.NextOutput(ProcessVariable)

Developing Control Event Routines
After configuring controls in the forms editor, you can write Visual Bas
code to respond to events on the controls. The controls generate thes
events in response to user interactions with the controls or in respons
some other occurrence in the control.

To develop the event handler routine code for an ActiveX control in Visu
Basic, double click the control to open the code editor, which automatic
generates a default event handler routine for the control. The event han
routine skeleton includes the control name, the default event, and any
parameters that are passed to the event handler routine.

The following code is an example of the event routine generated for th
PID control. This event routine (AutotuneComplete ) is called when the 
autotuning process has completed.

Private Sub CWPID1_AutotuneComplete

(ByVal NewParameterPosition As Long)

End Sub

To generate an event handler for a different event of the same control,
double click the control to generate the default handler, and select the
desired event from the right pull-down menu in the code window, as sho
in Figure 3-3.
© National Instruments Corporation 3-5 ComponentWorks Autotuning PID



Chapter 3 Building ComponentWorks Applications with Visual Basic

e to 

nd 
 of 
. To 

ular 
r. 
f 
l file 

 
trol, 
em 
ht 
ct or 
Figure 3-3.  Selecting Events in the Code Window

Use the left pull-down menu in the code window to change to another 
control without going back to the form window.

Using the Object Browser to Build Code in Visual Basic
Visual Basic includes a tool called the Object Browser that you can us
work with ActiveX controls while creating your program. The Object 
Browser displays a detailed list of the available properties, methods, a
events for a particular control. It presents a three-step hierarchical view
controls or libraries and their properties, methods, functions, and events
open the Object Browser, select Object Browser from the View menu, or 
press <F2>.

In the Object Browser, use the top left pull-down menu to select a partic
ActiveX control file. You can select any currently loaded control or drive
The Classes list on the left side of the Object Browser displays a list o
controls, objects, and function classes available in the selected contro
or driver.

Figure 3-4 shows the ComponentWorks PID control file selected in the
Object Browser. The Classes list shows the PID control, LeadLag con
Ramp control, and associated object types. Each time you select an it
from the Classes list in the Object Browser, the Members list on the rig
side displays the properties, methods, and events for the selected obje
class.
ComponentWorks Autotuning PID 3-6 © National Instruments Corporation
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Figure 3-4.  Viewing CWPID in the Object Browser

When you select an item in the Members list, the prototype and descrip
of the selected property, method, or function are displayed at the bottom
the Object Browser dialog box. In Figure 3-4, the CWPID control is 
selected from the Classes list. For this control, the NextOutput  method is 
selected and the prototype and description of the method appear in th
dialog box. The prototype of a method or function lists all parameters,
required and optional. 

When you select a property of a control or object in the Members list wh
is an object in itself, the description of the property includes a referenc
the object type of the property. For example, Figure 3-5 shows the CW
control selected in the Classes list and its Parameters  property selected in 
the Members list. 
© National Instruments Corporation 3-7 ComponentWorks Autotuning PID
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Figure 3-5.  Viewing the Parameters Sub-Object in the Object Browser

The Parameters object on the CWPID control is a separate object, so 
description at the bottom of the dialog window lists the Parameters prop
as CWPIDParameters. CWPIDParameters is the type name of the 
Parameters collection object, and you can select CWPIDParameters in
Classes list to see its properties and methods. Move from one level of
object hierarchy to the next level using the Object Browser to explore t
structure of different controls. 

The question mark (?) button at the top of the Object Browser opens the
help file to a description of the currently selected item. To find more 
information about the CWPID control, select the control in the window a
press the ? button.

Pasting Code into Your Program
If you open the Object Browser from the Visual Basic code editor, you c
copy the name or prototype of a selected property, method, or function
the clipboard and then paste it into your program. To perform this task
select the desired Member item in the Object Browser. Press the Copy to 
Clipboard  button at the top of the Object Browser or highlight the 
prototype at the bottom and press <Ctrl-C> to copy it to the clipboard. P
it into your code window by selecting Paste from the Edit  menu or pressing 
<Ctrl-V>.
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Use this method repeatedly to build a more complex reference to a prop
of a lower-level object in the object hierarchy. For example, you can cre
a reference to 

CWPID1.Parameters.Item(1).ProportionalGain

by typing in the name of the control (CWPID1) and then using the Object 
Browser to add each section of the property reference.

Adding Code Using Visual Basic Code Completion
Visual Basic 5 supports automatic code completion in the code editor.
you enter the name of a control, the code editor prompts you with the na
of all appropriate properties and methods. Try placing a control on the f
and then entering its name in the code editor. After typing the name, a
period as the delimiter to the property or method of the control. As soon
you type the period, Visual Basic drops down a menu of available 
properties and methods, as shown in Figure 3-6.

Figure 3-6.  Visual Basic 5 Code Completion

You can select from the list of properties and events by scrolling throu
the list and selecting one or by typing in the first few letters of the desi
item. Once you have selected the correct item, type the next logical 
character such as a period, space, equal sign, or carriage return to ent
selected item in your code and continue editing the code.
© National Instruments Corporation 3-9 ComponentWorks Autotuning PID
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Building ComponentWorks 
Applications with Visual C++

This chapter describes how you can use ComponentWorks controls w
Visual C++, explains how to insert the controls into the Visual C++ 
environment and create the necessary wrapper classes, shows you ho
create an application compatible with the ComponentWorks controls us
the Microsoft Foundation Classes Application Wizard (MFC AppWizar
and how to build your program using the ClassWizard with the control
and discusses how to perform these operations using ActiveX controls
general.

Note The descriptions and figures in this chapter apply specifically to the Visual C++
environment.

Developing Visual C++ Applications
The following procedure explains how you can start developing Visua
C++ applications with ComponentWorks.

1. Create a new workspace or project in Visual C++.

2. To create a project compatible with the ComponentWorks ActiveX
controls, use the Visual C++ MFC AppWizard to create a skeleton
project and program.

3. After building the skeleton project, add the ComponentWorks contr
to the controls toolbar. From the toolbar, you can add the controls
the application itself.

4. After adding a control to your application, configure its properties 
using its property pages.

5. While developing your program code, use the control properties a
methods and create event handlers to process different events 
generated by the control.

Create the necessary code for these different operations using the
ClassWizard in the Visual C++ environment.
s Autotuning PID
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Creating Your Application
When developing new applications, use the MFC AppWizard to create n
project workspace so the project is compatible with ActiveX controls. T
MFC AppWizard creates the project skeleton and adds the necessary 
that enables you to add ActiveX controls to your program.

1. Create a new project by selecting New from the File menu. The New 
dialog box opens (see Figure 4-1).

2. On the Projects tab, select the MFC AppWizard (exe) and enter the
project name and the directory.

Figure 4-1.  New Dialog Box

3. Click OK  to setup your project.

Complete the next series of dialog windows in which the MFC 
AppWizard prompts you for different project options. If you are a ne
Visual C++ or the MFC AppWizard user, accept the default option
unless otherwise stated in this documentation.

4. In the first step, select the type of application you want to build. 
For this example, select a dialog-based application, as shown in 
Figure 4-2, to make it easier to become familiar with the 
ComponentWorks controls.
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Figure 4-2.  MFC AppWizard—Selecting a Dialog-Based Application

5. Click the Next> button to continue. 

6. Enable ActiveX controls support. If you have selected a dialog-ba
application, step two of the MFC AppWizard enables ActiveX 
Controls support by default.

7. Continue selecting desired options through the remainder of the M
AppWizard. When you finish the MFC AppWizard, it builds a projec
and program skeleton according to the options you specified. The
skeleton includes several classes, resources, and files, all of whic
can be accessed from the Visual C++ development environment.

8. Use the Workspace window, which you can select from the View 
menu, to see the different components in your project.

Adding ComponentWorks Controls to the Visual C++ Controls Toolbar
Before building an application using the ComponentWorks controls, yo
must load the controls into the Controls toolbar in Visual C++ from the
Component Gallery in the Visual C++ environment. When you load th
controls using the Component Gallery, a set of C++ wrapper classes i
automatically generated in your project. You must have wrapper class
to work with the ComponentWorks controls.
© National Instruments Corporation 4-3 ComponentWorks Autotuning PID
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The Controls toolbar is visible in the Visual C++ environment only whe
the Visual C++ dialog editor is active. Use the following procedure to op
the dialog editor.

1. Open the Workspace window by selecting Workspace from the View 
menu.

2. Select the Resource View (second tab along the bottom of the 
Workspace window).

3. Expand the resource tree and double click one of the Dialog entrie

4. If necessary, right click any existing toolbar and enable the Contro
option.

By adding controls to your project, you create the necessary wrapper 
classes for the control in your project and add the control to the toolbo
Use the following procedure to add new controls to the toolbar.

1. Select Project»Add To Project»Components and Controls and, 
in the following dialog, double click Registered ActiveX Controls.

2. Select the ComponentWorks PID control and click the Insert button.

3. Click OK  in the following dialog windows. Repeat Steps 1 through
to add other controls.

4. When you have inserted the controls, click Close in the Components 
and Controls Gallery.

Building the User Interface Using ComponentWorks
After adding the controls to the Controls toolbar, use the controls in th
design of the application user interface. Place the controls on the dialo
form using the dialog editor. You can size and move individual control
in the form to customize the interface. Use the custom property sheets
configure control representation on the user interface and control beha
at run time.

To add ComponentWorks controls to the form, open the dialog editor b
selecting the dialog form from the Resource View of the Workspace 
window. If the Controls toolbar is not displayed in the dialog editor, open
by right clicking on any existing toolbar and enabling the Controls opti

To place a ComponentWorks control on the dialog form, select the des
control in the Controls toolbar and click and drag the mouse on the form
create the control. After placing the controls, move them on the form a
needed.
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After you add a ComponentWorks control to a dialog form, configure t
default properties of the control by right clicking the control and selecti
Properties to display its custom property sheets. Figure 4-3 shows the
CWPID control property pages.

Figure 4-3.  CWPID Control Property Pages in Visual C++

Programming with the ComponentWorks Controls
To program with ComponentWorks controls, use the properties, metho
and events of the controls as defined by the wrapper classes in Visual 

Before you can use the properties or methods of a control in your Visu
C++ program, assign a member variable name to the control. This mem
variable becomes a variable of the application dialog class in your pro

To create a member variable for a control on the dialog form, right click 
control and select ClassWizard. In the MFC Class Wizard window, 
activate the Member Variables tab, as shown in Figure 4-4.

Select the new control in the Control IDs field and press the Add Variable 
button. In the dialog window that appears, complete the member varia
name and press OK . Most member variable names start with m_, and you 
should adhere to this convention. After you create the member variable
it to access a control from your source code. Figure 4-4 shows the MF
Class Wizard after member variables have been added for the PID co
© National Instruments Corporation 4-5 ComponentWorks Autotuning PID
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Figure 4-4.  MFC ClassWizard—Member Variable Tab

Using Properties
Unlike Visual Basic, you do not read or set the properties of 
ComponentWorks controls directly in Visual C++. Instead, the wrappe
class of each control contains functions to read and write the value of e
property. These functions are named starting with either Get  or Set  
followed by the name of the property. For example, to set the Setpoint  
property of a PID control, use the SetSetpoint  function of the wrapper 
class for the PID control. In the source code, the function call is prece
by the member variable name of the control to which it applies.

m_CWPID1.SetSetpoint(50);

Some values passed to properties need to be of variant type. Convert 
value passed to the property to a variant using COleVariant() . For 
example, set the Item  property of the CWParameters object.

m_CWPID1.GetParameters().Item(COleVariant(1.0));

You can view the names of all the property functions (and other functio
for a given control in the ClassView of the Workspace window. In the 
Workspace window, select ClassView and then the control for which you 
ComponentWorks Autotuning PID 4-6 © National Instruments Corporation
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want to view property functions and methods. Figure 4-5 shows the 
functions for the PID object as listed in the Workspace. These are cre
automatically when you add a control to the Controls toolbar in you proj

Figure 4-5.  Viewing Property Functions and Methods in the Workspace Window

If you need to access a property of a control which is in itself another 
object, use the appropriate property function to return the sub-object o
control. Make a call to access the property of the sub-object. Include t
header file in your program for any new objects. For example, use the
following code to set the RelayAmplitude  on the PID control.

#include "cwpidautotune.h"

CCWPIDAutotune Autotune;

Autotune = m_CWPID1.GetAutotune();

Autotune.SetRelayAmplitude(10);

You can chain this operation into one function call without having to 
declare another variable.

#include "cwpidautotune.h"

m_CWPID1.GetAutotune().SetRelayAmplitude(10);
© National Instruments Corporation 4-7 ComponentWorks Autotuning PID
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If you need to access an object in a collection property, use the Item  
method with the index of the object. Remember to include the header 
for the collection object. For example, to set the proportional gain of th
first Parameter object on a PID control, use the following code.

#include "cwpidparameters.h"

#include "cwpidparameter.h"

m_CWPID1.GetParameters().Item(COleVariant(1.0)).

SetProportionalGain(15);

Using Methods
Use the control wrapper classes to extract all methods of the control. To
a method, append the method name to the member variable name and
the appropriate parameters. If the method does not require parameters
a pair of empty parentheses.

m_CWPID1.Reset();

Some methods take some parameters as variants. You must convert a
such parameter to a variant if you have not already done so. You can co
most scalar values to variants with COleVariant() . For example, the 
Remove method of the Parameters object requires a scalar value as va

m_CWPID1.GetParameters().Remove(COleVariant(1.0));

Note Consult Visual C++ documentation for more information about variant data type

If you need to call a method on a sub-object of a control, follow the 
conventions outlined in the Using Properties section earlier in this chapter.
For example, to call StartAutotune  on the Autotune object, use the 
following line of code.

#include "cwpidautotune.h"

m_CWPID1.GetAutotune().StartAutotune(10);

Using Events
After placing a control on your form, you can start defining event hand
functions for the control in your code. Controls generate events 
automatically at run time when they respond to specific conditions.

Use the following procedure to create an event handler.

1. Right click a control and select ClassWizard.

2. Select the Message Maps tab and the desired control in the Object ID
field. The Messages field displays the available events for the sele
control. (See Figure 4-6.)
ComponentWorks Autotuning PID 4-8 © National Instruments Corporation



Chapter 4 Building ComponentWorks Applications with Visual C++

e 
 can 

 the 

he 
3. Select the event and press the Add Function button to add the event 
handler to your code.

4. To switch directly to the source code for the event handler, click th
Edit Code button. The cursor appears in the event handler, and you
add the functions to call when the event occurs. You can use the Edit 
Code button at any time by opening the class wizard and selecting
event for the specific control.

The following figure is an example of an event handler generated for t
AutotuneComplete  event of the PID control.

void CCWPIDDlg::OnAutotuneCompleteCwpid1(long 

NewParameterPosition) 

{

m_CWPID1.SetActiveParameter(m_CWPID1.GetParameters().

Item(COleVariant(NewParameterPosition)));

}

Figure 4-6.  Event Handler
© National Instruments Corporation 4-9 ComponentWorks Autotuning PID
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Building ComponentWorks 
Applications with Delphi

This chapter describes how you can use ComponentWorks controls w
Delphi; insert the controls into the Delphi environment, set their propert
and use their methods and events; and perform these operations usin
ActiveX controls. This chapter also outlines Delphi features that simpli
working with ActiveX controls.

Note The descriptions and figures in this chapter apply specifically to the Delphi 3 
environment. If you have the original release of Delphi 3, you might experience
significant problems with ActiveX controls, but Borland offers a newer version o
Delphi that corrects most of these problems. Before using ComponentWorks w
Delphi 3, contact Borland to receive the Delphi 3 patch or a newer version.

Running Delphi Examples
To run the Delphi examples installed with ComponentWorks, you need
import the controls into the Delphi environment. See the section on 
Loading ComponentWorks Controls into the Component Palette for more 
information about loading the controls.

Developing Delphi Applications
You start developing applications in Delphi using a form. A form is a 
window or area on the screen on which you can place controls and 
indicators to create the user interface for your programs. The Compon
palette in Delphi contains all of the controls available for building 
applications. After placing each control on the form, configure the 
properties of the control with the default and custom property pages. 
Each control you place on a form has associated code (event handler
routines) in the Delphi program that automatically executes when the 
user operates the control or the control generates an event.
s Autotuning PID
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Loading ComponentWorks Controls into the Component Palette
Before you can use the ComponentWorks controls in your Delphi 
applications, you must add them to the Component palette in the Delp
environment. You need to add the controls to the palette only once bec
the controls remain in the Component palette until you explicitly remov
them. When you add controls to the palette, you create Pascal import u
(header files) that declare the properties, methods, and events of a co
When you use a control on a form, a reference to the corresponding im
unit is automatically added to the program.

Note Before adding a new control to the Component palette, make sure to save all y
work in Delphi, including files and projects. After loading the controls, Delphi 
closes any open projects and files to complete the loading process.

Use the following procedure to add ActiveX controls to the Componen
palette.

1. Select Import ActiveX Control  from the Component menu in the 
Delphi environment. The Import ActiveX Control window displays 
list of currently registered controls.

Figure 5-1.  Delphi Import ActiveX Control Dialog Box
ComponentWorks Autotuning PID 5-2 © National Instruments Corporation
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2. Select National Instruments CW PID to add the PID controls to the
Component palette.

3. After selecting the control group, click Install .

Delphi generates a Pascal import unit file for the selected .OCX file, 
which is stored in the Delphi \Imports  directory. If you have installed 
the same .OCX file previously, Delphi prompts you to overwrite the 
existing import unit file.

4. In the Install  dialog box, click OK  to add the controls to the Delphi 
user’s components package.

5. In the following dialog, click Yes to rebuild the user’s components 
package with the added controls. Another dialog box acknowledge
the changes you have made to the user’s components package, an
package editor displays the components currently installed.

At this point, you can add additional ActiveX controls with the 
following procedure.

a. Click the Add button.

b. Select the Import ActiveX  tab.

c. Select the ActiveX control you want to add.

d. Click OK .

e. After adding the ActiveX controls, compile the user’s compone
package.

If your control does not appear in the list of registered controls, click th
Add button. To register a control with the operating system and add it to
list of registered controls, browse to and select the OCX file that conta
the control. Most OCX files reside in the \Windows\System(32)  
directory.

New controls are added to the ActiveX tab in the Components palette. You
can rearrange the controls or add a new tab to the Components palett
right clicking on the palette and selecting Properties.

Building the User Interface
After you add the ComponentWorks controls to the Component palette,
them to create the user interface. Open a new project, and place diffe
controls on the form. After placing the controls on the form, configure th
default property values through the stock and custom property sheets
© National Instruments Corporation 5-3 ComponentWorks Autotuning PID
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Placing Controls
To place a control on the form, select the control from the Component
palette and click and drag the mouse on the form. Use the mouse to m
controls to customize the interface, as in Figure 5-2. After you place th
controls, you can change their default property values by using the def
property sheet (Object Inspector) and custom property sheets.

Figure 5-2.  ComponentWorks Controls on a Delphi Form

Using Property Pages
Set property values such as Name in the Object Inspector of Delphi. To 
open the Object Inspector, select Object Inspector from the View menu or 
press <F11>. Under the Properties tab of the Object Inspector, you can se
different properties of the selected control.
ComponentWorks Autotuning PID 5-4 © National Instruments Corporation
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Figure 5-3.  Delphi Object Inspector

To open the custom property pages of a control, double click the contro
right click the control and select Properties. You can edit most control 
properties from the custom property pages. The following figure shows
ComponentWorks PID control property page.

Figure 5-4.  ComponentWorks PID Control Property Pages in Delphi
© National Instruments Corporation 5-5 ComponentWorks Autotuning PID
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Programming with ComponentWorks
The code for each form in Delphi is listed in the Associated Unit (code
window. You can toggle between the form and Associated Unit window
pressing <F12>. After placing controls on the form, use their methods
your code and create event handler routines to process events genera
the controls at run time.

Using Your Program to Edit Properties
You can set or read control properties programmatically by referencin
the name of the control with the name of the property, as you would an
variable name in Delphi. The name of the control is set in the Object 
Inspector.

The syntax for setting the Value  property in Delphi is 

name.property := new_value;

For example, you can set the Setpoint  property of a PID control using 
the following line of code, where CWPID1 is the default name of the PID 
control.

CWPID1.Setpoint := 50;

A property can be an object itself that has its own properties. To set 
properties in this case, combine the name of the control, sub-object, a
property. For example, consider the following code for the PID control.
Autotune  is both a property of the PID control and an object itself. 
RelayAmplitude  is a property of the Autotune object. As an object of 
the PID control, Autotune itself has several additional properties.

CWPID1.Autotune.RelayAmplitude := 2;

You can retrieve the value of a control property from your program in t
same way. For example, you can assign the relay amplitude to a text b
on the user interface.

Edit1.Text := CWPID1.Autotune.RelayAmplitude;

To use the properties or methods of an object in a collection, use the Item  
method to extract the object from the collection. Once you extract the 
object, use its properties and methods as you usually would.

CWPID1.Parameters.Item(1).ProportionalGain := 10;
ComponentWorks Autotuning PID 5-6 © National Instruments Corporation
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Using Methods
Each control has defined methods that you can use in your program. To
a method in your program, use the control name followed by the meth
name.

CWPID1.Reset;

Some methods require parameters. In most cases, parameters passe
method are of type variant. Simple scalar values can be automatically
converted to variants and, therefore, might be passed to methods.

Using Events
Use event handler routines in your source code to respond to and pro
events generated by the ComponentWorks controls. Events are gene
by user interaction with an object in response to internal conditions (fo
example, completed acquisition or an error). You can create a skeleton
an event handler routine using the Object Inspector in the Delphi 
environment.

To open the Object Inspector, press <F11> or select Object Inspector from 
the View menu. In the Object Inspector, select the Events tab. This tab, 
as shown in the following figure, lists all the events for the selected cont
To create a skeleton function in your code window, double click the em
field next to the event name. Delphi generates the event handler routin
the code window using the default name for the event handler.

Figure 5-5.  Delphi Object Inspector Events Tab

To specify your own event handler name, click the empty field in the Ob
Inspector next to the event, and enter the function name. After the eve
handler function is created, insert the code in the event handler. The 
following is an example of the event handler function for the 
AutotuneComplete  event of the PID control.

procedure TForm1.CWPID1AutotuneComplete(Sender: 

TObject;NewParameterPosition: Integer);

begin

end;
© National Instruments Corporation 5-7 ComponentWorks Autotuning PID
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Using the ComponentWorks 
Autotuning PID Control

This section describes the ComponentWorks PID, LeadLag, and Ram
controls. These chapters contain overviews of the controls and their m
commonly used properties, methods, and events; short code segmen
illustrate programmatic control; and tutorials that lead you through 
building an application with the controls.

Part II, Using the ComponentWorks Autotuning PID Control, contains the 
following chapters.

• Chapter 6, Using the PID Control, describes the Autotuning PID 
control and includes a tutorial with step-by-step instructions for usi
the control. This chapter also introduces the LeadLag and Ramp 
controls.

• Chapter 7, PID Examples, describes examples included with the 
ComponentWorks PID software.
ion II-1 ComponentWorks Autotuning PID
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Using the PID Control

This chapter describes the Autotuning PID control and includes a tuto
with step-by-step instructions for using the control. This chapter also 
introduces the LeadLag and Ramp controls.

You can find additional information about the PID control in the 
ComponentWorks Autotuning PID Online Reference, available by 
selecting Programs»National Instruments ComponentWorks» 
Autotuning PID»ComponentWorks PID Reference from the 
WindowsStart menu.

PID Control
The PID control implements the PID algorithm, which you can find 
information about in Chapter 8, Algorithms. The PID control, CWPID, 
is built from a hierarchy of object, as illustrated in Figure 6-1.

Figure 6-1.  PID Control Object Hierarchy

PID Control
Properties:

Autotune, Parameters

Autotune Object
Properties: NoiseLevel, 

RelayAmplitude

Parameters Collection
Property: Count

Parameter Object
Properties: IntegralTime,

ProportionalGain
s Autotuning PID



Chapter 6 Using the PID Control

to 
ges 
d to 
rty 

 
tes 
call 

s 
n 

ter 

ling 

 

PID Object
The PID object contains several properties and methods you can use 
configure the PID control, and you can set properties in the property pa
during design and change them programmatically at run time. You nee
set the proportional gain, derivative time, and integral time in the prope
pages before run time.

NextOutput  returns the next output from the PID algorithm given the 
controls current settings and a process variable.

Output = CWPID1.NextOutput(ProcessVariable)

You can have the object automatically determine the amount of time 
between successive calls to the control, or specify it yourself using the
DeltaT  property. If you use the built-in time keeper, the object calcula
new timing information at each call, measuring the time since the last 
and using that difference in its calculations. 

Note If you use the built-in timer, remember that tick timer resolution is limited to 1 m
on Windows 95 and NT. Do not try to run the PID methods faster than 10 Hz whe
using the built-in timer.

Parameters Collection
The Parameters collection is a standard collection containing Parame
objects. The collection contains one property, Count , that returns the 
number of Parameter objects in the collection.

NumParameters = CWPID1.Parameters.Count

Use the Add, Remove, and RemoveAll  methods to programmatically 
change the number of Parameter objects in the PID control. When cal
the Remove method, include the index of the Parameter object to be 
removed.

CWPID1.Parameters.Add "param1", 10.0, 0.015, 0.001, 0

CWPID1.Parameters.Remove 3

Use the Item  method of the Parameters collection to access a specific
Parameter object in the collection.
ComponentWorks Autotuning PID 6-2 © National Instruments Corporation
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Parameter Object
The Parameter object represents an individual parameter in the PID con
The Parameter object contains a number of different properties that you
use to determine the next output of the control.

You can set IntegralTime , ProportionalGain , and 
DerivativeTime  as shown in the following code.

CWPID1.Parameters.Item(1).ProportionalGain = 10.0

CWPID1.Parameters.Item(1).Integraltime = 0.015

CWPID1.Parameters.Item(1).DerivativeTime = 0.001

Autotune Object
The Autotune object has four properties needed to autotune the PID 
parameters. For more information about autotuning or the autotuning 
algorithm, refer to Chapter 8, Algorithms.

• NoiseLevel —Amount of noise in the system.

• RelayAmplitude —Amplitude the Autotune object should use whe
modifying the setpoint during the relay process.

• ControlDesign —Design of the controller for which the Autotune 
object should calculate new PID parameters. Valid values include F
Normal, and Slow.

• ControlType —Type of controller for which the Autotune object 
should calculate new PID parameters. Valid values include PID, P
and P.

Several methods can help you autotune PID parameters:

• ShowDialog —Displays the Autotune Wizard that steps you throug
the autotune process. Refer to Autotune Wizard for more information.

• StartNoiseEstimate —Begins a process that determines the 
amount of noise in the system.

• StartRelay —Begins the relay process and stabilizes it. For more
information about the relay process, see Chapter 8, Algorithms.

• StartAutotune —Tunes the PID parameters.

Note You must call the StartRelay  method before you can call the StartAutotune  
method.
© National Instruments Corporation 6-3 ComponentWorks Autotuning PID
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Autotune Wizard
The Autotune Wizard performs the following steps to guide you throug
the following autotuning process, which you can cancel anytime witho
affecting the current control state.

1. Determine the amount of noise in the system. If you know the amo
of noise, you can specify it, and the wizard will not calculate it.

2. Begin the relay process. The wizard prompts you for information 
needed to autotune the PID parameters. After you enter this 
information, the wizard starts the relay process. 

3. Autotune the PID parameters. When you specify that the relay proc
is stabilized, the wizard begins autotuning the PID parameters.

4. Display the new PID parameters. At this point, you can accept the 
PID parameters or cancel the process.

PID Events
To signal when the noise estimate and autotuning process has finishe
the CWPID object generates two events: AutotuningComplete  and 
NoiseEstimateComplete . The control also generates an event every 
time the relay process completes a cycle.

LeadLag Control
The LeadLag control, CWLeadLag, calculates the dynamic compensa
in feedforward control schemes. Properties of CWLeadLag include Gain , 
LagTime , and LeadTime . The NextOutput  method returns the next value
given the current state of the control. 

You can have the object automatically determine the amount of time 
between successive calls to the control, or specify it yourself using the
DeltaT  property. If you use the built-in time keeper, the object calcula
new timing information at each call, measuring the time since the last 
and using that difference in its calculations. 

Note If you use the built-in timer, remember that tick timer resolution is limited to 1 m
on Windows 95 and NT. Do not try to run the PID methods faster than 10 Hz whe
using the built-in timer.
ComponentWorks Autotuning PID 6-4 © National Instruments Corporation
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Ramp Control
The Ramp control, CWRamp, generates a setpoint ramp. Use the Rate  
property to determine how fast the value is ramped to the Setpoint  
property.

You can have the object automatically determine the amount of time 
between successive calls to the control, or specify it yourself using the
DeltaT  property. If you use the built-in time keeper, the object calcula
new timing information at each call, measuring the time since the last 
and using that difference in its calculations.

Note If you use the built-in timer, remember that tick timer resolution is limited to 1 m
on Windows 95 and NT. Do not try to run the PID methods faster than 10 Hz whe
using the built-in timer.

Tutorial: Using the PID Control
This tutorial shows you how to configure the PID control and autotune 
PID parameters. This tutorial is divided into two parts:

• Develop a PID system

• Autotune PID parameters

Although the code and examples in the tutorial use Visual Basic synta
you can apply the concepts and implement the steps in any programm
environment. Remember to adjust all code to your specific programmi
language.

Part 1: Develop a PID System
In the first part of this tutorial, you use a CWPID object to control a know
process.

Designing the Form
1. Open a new project and form. In Visual C++, select a dialog-base

application and name your project SimplePIDExample .

2. Load the ComponentWorks PID control into your programming 
environment.

3. Place a CWPID control on the form. Keep its default name, CWPID1. 
You configure its properties in the next section, Setting the PID 
Properties.
© National Instruments Corporation 6-5 ComponentWorks Autotuning PID
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4. Place three Visual Basic TextBoxes on the form and name them 
ProcessVariable , Setpoint , and ControllerOutput . Add a 
corresponding label to each text box.

5. Set ProcessVariable  to 0 and Setpoint  to 50.

6. Place a Visual Basic Timer control on the form and set its Interval  
to 100  ms.

Figure 6-2.  Simple PID Example Form

Setting the PID Properties
You normally configure the default property values of the different contr
before you develop your program code. When using the PID control, y
will set most properties, if not all, during design and will not change the
during program execution. Use this program to start and stop the PID 
process only. If necessary, you can edit the properties of the PID cont
at run time.

1. Open the custom property pages for the CWPID control on the fo
by right clicking on the control and selecting Properties.

2. On the Parameters page, click the Add button in the Parameters group
and set the following parameters.

Proportional Gain (Kc) 10

Integral Time (Ki) 0.015

Derivative Time (Kd) 0.001

3. On the General page, change the Setpoint  value to 50.
ComponentWorks Autotuning PID 6-6 © National Instruments Corporation
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Developing the Code
In the following steps, you add the code to apply the PID algorithm. 
Normally, the PID control calculates a new output (controller output) th
you apply to your physical system. In this tutorial, you simulate a real 
process by calculating a new process variable using the controller out
and a simple formula. In real systems the process variable is measured
the physical system after applying the controller output.

1. Create an event handler for the Change  event of the Setpoint textbox.
Add the following code to the event handler to update the setpoint
when it changes.
CWPID1.Setpoint = Val(Setpoint.Text)

2. Create the event handler for the Timer  event of the Timer control. In 
the Timer  event, calculate the next controller output using the PID
control and current process variable. Then calculate the correspon
process variable using a simulation formula. Add the following code
the event handler.

' Calculate controller output

ControllerOutput = 

CWPID1.NextOutput(ProcessVariable)

' Calculate new (simulated) process variable

' from controller output

ProcessVariable = ProcessVariable + 

(ControllerOutput * 0.02) + (Rnd – 0.5)

If you have a graph control to display the data, you can add a line
code to display the current values of the three variables. For exam
if you have the ComponentWorks graph control, you can use the 
following code:

CWGraph1.ChartY Array(ProcessVariable, 

ControllerOutput, Setpoint), 1, False
© National Instruments Corporation 6-7 ComponentWorks Autotuning PID
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Testing Your Program
Run your program. Once the program starts, the PID control drives th
process variable to the setpoint. Your application should look similar to
following figure. Notice the process variable converging on the setpoin
and oscillating around the setpoint when it reaches the setpoint value.
Better PID parameters decrease the amplitude of the oscillation.

Figure 6-3.  Testing the Simple PID Example

When you change the setpoint value, the PID controller drives the pro
variable to the new setpoint value.

Part 2: Autotune PID Parameters
In the second part of this tutorial, you add autotuning to improve the P
parameters for your system or process.

Designing the Form
Add a button and change its caption to Autotune .
ComponentWorks Autotuning PID 6-8 © National Instruments Corporation
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Setting PID Properties
1. On the Autotune property page for the PID control, change Noise level 

to 0.25  and Relay amplitude to 2.

2. Check the Apply autotune results to the active parameters box.

Developing the Code
Define an event handler routine for the Click  event of the Autotune 
button. In the event handler, call the ShowDialog  method of the 
CWPIDAutotune property object with the parameter cwpid20ms .

CWPID1.Autotune.ShowDialog cwpid20ms

Testing Your Program
Run your program. Allow the process to settle and then press the Autotune 
button. The Autotune Wizard is displayed, and you can follow the 
directions in the wizard to optimize the PID parameters.
© National Instruments Corporation 6-9 ComponentWorks Autotuning PID
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PID Examples

This chapter describes examples included with the ComponentWorks
Autotuning PID software.

AutotunePID

The AutotunePID example is an extension of the GeneralPID example
which is described in the General PID section. Press the Autotune button 
to display the Autotune Wizard. The Autotune Wizard leads you throu
the autotuning process. When the autotuning process is complete, the
parameter controls are updated with the autotuned parameters.

Cascade and Selector
This example demonstrates a cascade and selector control, which simu
a compressor driven by a motor with a tachometer requiring a PID loo
control the speed (the downstream loop). The flow and pressure from 
compressor pass to individual PID controllers.

You want to control the flow, but if the pressure exceeds a specified 
setpoint, the pressure becomes the controlled variable. This calls for a
select function to combine the two upstream controller outputs. The lo
of the two outputs becomes the setpoint for the compressor speed. 

Note All variables in this simulation are percentages. In a real application, you migh
want to normalize all the input and setpoint values to percentages before pass
them to the PID controllers.

The downstream loop (also known as the inner loop), which is the 
compressor speed control, must be faster than the outer loops. You sh
use a factor of 10 to prevent oscillation. In this simulation, the compres
lag is smaller (faster) than that of the outer loops.
s Autotuning PID
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General PID
The General PID example demonstrates how to use the PID control in
simple Plant Simulator scenario. Like the Tank Level example, this 
pressure controller simulation uses the Plant Simulator subroutines.

LeadLag
The LeadLag example uses the LeadLag method. Excitation for the 
LeadLag example is either a sine wave or a square wave. The wavefo
is synchronized to the cycle time you choose. By varying the tuning 
parameters, you can see the time-domain response of the LeadLag 
example. A large lead setting causes a wild ringing on the output, whi
large lag setting heavily filters the signal, almost making it disappear.

PID with MIO Board
The PID with MIO Board example turns your computer into a single-lo
PID controller through the use of a National Instruments data acquisiti
board. Connect the analog output to the analog input through the 
resistor-capacitor network shown on the picture below.

Note You must have the appropriate hardware to run this example. The pin number
shown in Figure 7-1 correspond to the standard MIO pinouts, such as a standa
50-pin cable from an E-series DAQ board.

Figure 7-1.  Resistor-Capacitor Network

This example adjusts the analog output so that the input (process vari
or PV) equals the setpoint (SP). The example displays SP and PV on a
chart. You can experiment with different controller tuning methods and
ComponentWorks Autotuning PID 7-2 © National Instruments Corporation
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for the fastest settling time with the least overshoot. The default tuning
parameters are optimum for the network shown in Figure 7-1.

The input span is –10 to 10V, and the output span is 0 to 10V. PV and
are expressed in volts. Set your I/O board for differential input to ±10V
range, and the output to bipolar 10V range (these are all factory defau
If you use other settings, change the example constants for the data 
acquisition board configuration.

The recommended network has a DC gain of 0.33, an effective deadtim
about 5 s, and an effective time constant of about 30s.

To customize this demonstration example, add alarm limits that set the
digital output lines on the I/O board, remote setpoint (by using one of 
analog inputs), and remote automatic to manual switching (by using on
the digital inputs).

Note Try using the autotuning functionality to see the effect of autotuning the 
controller.

RampDemo
The RampDemo example uses the Ramp control to drive an initial valu
a setpoint using a specified rate and cycle time. While the initial value
driven to the setpoint, you can change the rate and cycle time to vary 
response of the control.

Tank Level
The Tank Level example is a process simulation for tank level. A leve
controller adjusts the flow into a tank. To represent a change in proce
loading, click the on/off value that serves as a drain. With this example
you also can switch between having the controller automatically determ
the output or using the manual control to select the output.

The Plant Simulator subroutine, which simulates this process, reads a
delays the previous valve position and scales it according to the proce
gain. The gain represents how fast the tank fills versus the position of 
valve. The process load value depends on the state of HV-101, the dra
valve. When you open the valve, the tank level drops. 
© National Instruments Corporation 7-3 ComponentWorks Autotuning PID
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PID Algorithms and Control Strategies

This section describes the Autotuning PID algorithms and basic contro
design systems.

Part III, PID Algorithms and Control Strategies, contains the following 
chapters.

• Chapter 8, Algorithms, explains the PID algorithm, the Autotuning 
algorithm, and how these algorithms are applied to control system

• Chapter 9, Designing Control Strategies, describes how you can 
design and implement control strategies with the PID, LeadLag, 
and Ramp controls.
ion III-1 ComponentWorks Autotuning PID
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Algorithms

This chapter explains the PID algorithm, the Autotuning algorithm, and
how these algorithms are applied to control systems.

PID Algorithm
In the PID (Proportional-Integral-Derivative) controller, the setpoint is 
compared to the process variable to obtain the error

e = SP – PV

You can then calculate the controller action theoretically as

where Kc is controller gain. If the error and the controller output have th
same range, that is –100% to 100%, controller gain is the reciprocal o
proportional band. Ti is the integral time in minutes (also called reset time), 
and Td is the derivative time in minutes (also called rate time). The 
proportional action is

the integral action is

 and the derivative action is

u t( ) Kc e 1
Ti
---- e t Td  de

dt
------+d

0

t

∫+ 
 =

up t( ) Kce=

u I  t( ) = 
Kc 

Ti
-------- e td

0
t∫

uD t( ) KcTd  de 
dt
-------=
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The PID control implements the positional PID algorithm as described
the following sections.

PV filtering —Process variable filtering minimizes the effects of noise.

Error calculation —The current error used in calculating integral action 
and derivative action is

The error for calculating proportional action is

where SPrng is the range of the setpoint,  (beta) is the setpoint factor (for
the Two Degree of Freedom PID algorithm described under Proportional 
Action), and L is the linearity factor that produces a nonlinear gain term
which the controller gain increases with the magnitude of the error. If L is 1, 
the controller is linear. A value of 0.1 makes the minimum gain of the 
controller 10% Kc. This use of a nonlinear gain term is referred to as an
Error-Squared PID algorithm.

Proportional Action —In applications, setpoint changes are normally 
greater and more rapid than load disturbances, while load disturbance
appear as a slow departure of the controlled variable from the setpoin
PID tuning for good load-disturbance responses often results in setpo
responses of unacceptable oscillation. On the other hand, tuning for g
setpoint responses often yields sluggish load-disturbance responses. 
factor , when set to less than 1, reduces the setpoint-response overs
without affecting the load-disturbance response. This is referred to as 
Two Degree of Freedom PID algorithm. Intuitively,  is an index of the 
setpoint response importance, from 0 to 1. For example, if you consid
load response the most important loop performance, set  to 0. Conver
if you want the process variable to follow the setpoint change quickly, 
set to 1.

PVf 0.5PV 0.25PV k 1–( ) 0.175PV k 2–( ) 0.075PV k 3–( )+ + +=

e(k) = (SP PVf)(L+ 1 L–( )*
SP PVf–

SPrng
-------------------------) –

eb k( ) (β* SP PVf)(L+ 1 L–( )*
βSP PVf–

SPrng
----------------------------) –=

β

β

β

β

β

uP k( )= Kc* eb k( )( )
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Trapezoidal Integration—Trapezoidal integration is used to avoid shar
changes in integral action when there is a PV or SP jump; nonlinear 
adjustment of integral action is used to counteract overshoot. The large
the error, the smaller the integral action, as shown in the following form
and Figure 8-1.

Figure 8-1.  Nonlinear Multiple for Integral Action (SPrng = 100)

Partial Derivative Action —Because of abrupt changes in setpoint (SP
derivative action is applied only to a filtered PV (not the error e) to avoid 
derivative kick.

Controller Output —Controller output is the summation of the 
proportional, integral, and derivative action.

uI k( )=
Kc

Ti
------ e i( ) e i 1–( )+

2
---------------------------------- t∆

i 1=

k

∑ 1

1 10*e i( )2

SPrng
2

---------------------+

-------------------------------

uD k( ) = Kc 
Td

∆t
----- PVf k( ) PVf k 1–( )–( )–

u k( ) uP k( ) uI k( ) u+
D

k( )+=
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Output Limiting —The actual controller output is limited to the range 
specified for control output.

and

the practical model of the PID controller is

The PID control uses an integral sum correction algorithm that facilitates 
anti-windup and bumpless automatic to manual and manual to automatic
transfers. Anti-windup is the upper limit of the controller output, for 
example, 100%. Once the error e decreases, the controller output decreas
and steps out of the windup area. This algorithm prevents abrupt contr
output changes when you switch from automatic to manual mode or fr
manual to automatic mode or change any other parameters.

The default ranges for the parameters setpoint, process variable, and 
output correspond to percentage values; however, you can use actual
engineering units. Adjust corresponding ranges accordingly. Reverse 
acting (also called increase-decrease) is the normal controller mode in 
which the output decreases if the process variable is greater than the 
setpoint. The parameters Ti and Td are specified in minutes. Switching to
hold mode or manual mode freezes the output at the current value. In
manual model, you can increase or decrease the output by changing 
manual input. All transfers, from automatic to manual or automatic to ho
and from manual to automatic or hold to automatic, are bumpless.

Note As a general rule, manually drive the process variable until it meets or approach
the setpoint before you perform the manual to automatic transfer.

Gain Scheduling
Gain scheduling describes a system where controller parameters are 
changed depending on measured operating conditions. For instance, 
scheduling variable can be the setpoint, the process variable, a contro
output, or an external signal. For historical reasons, the word gain 
scheduling is used even if other parameters such as derivative time or 
integral time change. Gain scheduling effectively controls a system who
dynamics change with the operating conditions. 

If u k( ) umax then u k( ) umax=≥

if u k( ) umin then u k( ) umin=≤

u t( ) Kc β( SP PV) + 1
Ti
---- (SP PV)dt Td 

dPVf

dt
------------––

0

t

∫–=
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In this software, you can define unlimited sets of PID parameters for g
scheduling. For each schedule you can run autotuning to update the 
PID parameters.

Autotuning Algorithm
Autotuning is used to improve performance. Often, many controllers a
poorly tuned—some too aggressive, some too sluggish. When you are
sure about disturbance or process dynamic characteristics, tuning a 
PID controller is difficult; therefore, the need for autotuning arises.

Figure 8-2 illustrates the autotuning procedure excited by the setpoint relay 
experiment, which connects a relay and an extra feedback signal with t
setpoint. The existing controller remains in the loop. 

Note Although it might be poorly tuned, a stable controller must be established befo
autotuning. 

Figure 8-2.  Process under PID Control with Setpoint Relay

For most systems, a limiting cycle generates because of the nonlinear 
characteristic. From this cycle, the autotuning algorithm identifies the 
relevant information needed for PID tuning:

• If the existing controller is proportional only, ultimate gain Ku and 
ultimate period Tu.

• If the existing model is PI or PID, dead time  and time constant Tp, 
which are two parameters in the integral-plus-deadtime model

τ

GP s( ) = e
τs–

Tps
--------- 
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Tuning Formulas
This package uses Ziegler and Nichols’ heuristic methods for determin
the parameters of a PID controller. When autotuning, select one of thr
types of loop performance: fast (1/4 damping ratio), normal (some 
overshoot), and slow (little overshoot). Refer to the following tuning 
formula tables for each type of loop performance.

Table 8-1.  Tuning Formula under P-only Control (fast)

Controller Kc Ti Td

P 0.5Ku

PI 0.4Ku 0.8Tu

PID 0.6Ku 0.5Tu 0.12Tu

Table 8-2.  Tuning Formula under P-only Control (normal)

Controller Kc Ti Td

P 0.2Ku

PI 0.18Ku 0.8Tu

PID 0.25Ku 0.5Tu 0.12Tu

Table 8-3.  Tuning Formula under P-only Control (slow)

Controller Kc Ti Td

P 0.13Ku

PI 0.13Ku 0.8Tu

PID 0.15Ku 0.5Tu 0.12Tu

Table 8-4.  Tuning Formula under PI Control (fast)

Controller Kc Ti Td

P Tp/τ

PI 0.9Tp/τ 3.33τ

PID 1.1Tp/τ 2.0τ 0.5τ
ComponentWorks Autotuning PID 8-6 © National Instruments Corporation
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Note During tuning, the process remains under closed-loop (PID) control. You do no
need to switch off the existing controller and perform the experiment under 
open-loop conditions. In the setpoint relay experiment, the SP signal mirrors th
SP for the PID controller.

Table 8-5.  Tuning Formula under PI Control (normal)

Controller Kc Ti Td

P 0.44Tp/τ

PI 0.4Tp/τ 5.33τ

PID 0.53Tp/τ 4.0τ 0.8τ

Table 8-6.  Tuning Formula under PI Control (slow)

Controller Kc Ti Td

P 0.26Tp/τ

PI 0.24Tp/τ 5.33τ

PID 0.32Tp/τ 4.0τ 0.8τ
© National Instruments Corporation 8-7 ComponentWorks Autotuning PID
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Designing Control Strategies

This chapter describes how you can design and implement control 
strategies with the PID, LeadLag, and Ramp controls.

When designing a control strategy, sketch a process flowchart showin
control elements (for example, valves) and measurements. Add feedb
and any required computations. Then translate the flowchart into code
using the ComponentWorks PID control. Figure 9-1 shows a process 
flowchart.

Figure 9-1.  Control Flowchart

The following Visual Basic code implements the process shown in 
Figure 9-1.

SP1 = CWLeadLag1.NextOutput(FT1)

CWPID1.Setpoint = SP1

Output1 = CWPID1.NextOutput(LT1)

CWPID2.Setpoint = Output1 + SP1

Valve = CWPID2.NextOutput(FT2)

You can handle the inputs and outputs through data acquisition (DAQ)
boards, FieldPoint I/O modules, GPIB instruments, or serial I/O ports.
s Autotuning PID
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Setting Timing
The PID , LeadLag , and RampGenerator  methods are time dependent. 
These methods can acquire timing information through a value you sup
or through a built-in time keeper. With the built-in time keeper, the 
methods calculate new timing information each time they are called. A
each call, the method measures the time since the last call and uses t
difference in its calculations. Tick timer resolution is limited to 1 ms on
Windows 95 and NT. Because of this limitation, do not try to run the P
methods faster than 10 Hz when using the built-in time keeper.

If you specify the timing information manually, the method uses the va
you specify in the calculations, regardless of the elapsed time. This me
should be used for fast loops, such as when controller input is timed w
acquisition hardware.

According to control theory, a sampled control system must run about
10 times faster than the fastest time constant in the plant under contro
For example, a temperature control loop is probably quite slow—a tim
constant of 60 s is common in a small system. In this case, a cycle tim
about 6 s is sufficient. Faster cycling offers no improvement in 
performance. 

If the control application does not contain graphics that must update 
frequently, the PID control can execute at kilohertz (kHz) rates. Remem
that actions such as mouse activity and window scrolling interfere with
these rates. 

Manual Tuning Techniques
The following controller tuning procedures are based on the work of 
Ziegler and Nichols, the developers of the Quarter-Decay Ratio tuning
techniques derived from a combination of theory and empirical 
observations. For different processes, one method might be easier or 
accurate than the other. Some techniques you can use with online 
controllers cannot stand the gross upsets described here.

To perform these tests, set up your control strategy with the process var
(PV), setpoint, and output displayed on a large strip chart with the axe
showing the values versus time. Perturb the loop as described in the 
Closed-Loop (Ultimate Gain) Tuning Procedure and Open-Loop (Step 
Test) Tuning Procedure sections of this chapter and determine the respon
from the graph.
ComponentWorks Autotuning PID 9-2 © National Instruments Corporation
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Closed-Loop (Ultimate Gain) Tuning Procedure
Although the closed-loop (ultimate gain) tuning procedure is very accur
you must put your process in steady-state oscillation and observe the
process variable on a strip chart. To perform the closed-loop tuning 
procedure, complete the following steps:

1. With the controller in automatic mode, carefully increase the 
proportional gain (Kc) in small steps. Disturb the loop after each ste
by making a small change in the setpoint. The process variable sh
start oscillating as you increase the Kc. Keep making changes until the
oscillation is perfectly sustained, neither growing nor decaying ove
time.

2. Record the controller proportional band as PBu as a percent, where 
PBu = 100 / Kc.

3. Record the period of oscillation as Tu in minutes.

4. Multiply the measured values by the factors shown in Table 9-1, 
and enter the new tuning parameters into your controller. The tabl
provides the proper values for a quarter-decay ratio. 

If you want less overshoot, reduce the gain Kc.

Note Proportional gain (Kc) is related to proportional band (PB) as Kc = 100 / PB.

Table 9-1.  Closed-Loop–Quarter-Decay Ratio Values

Controller PB (percent)
Reset 

(minutes) Rate (minutes)

P 2.00PBu — —

PI 2.22PBu 0.83Tu —

PID 1.67PBu 0.50Tu 0.125Tu
© National Instruments Corporation 9-3 ComponentWorks Autotuning PID
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Open-Loop (Step Test) Tuning Procedure
The open-loop (step test) tuning procedure assumes that you can mode
process as a first-order lag and a pure deadtime. This method requires
analysis than the closed-loop tuning procedure, but your process does
need to reach sustained oscillation. Therefore, the open-loop tuning 
procedure might be quicker and less hazardous for many processes. 
Observe the output and the process variable (PV) on a strip chart that s
time on the X axis. To perform the open-loop tuning procedure, compl
the following steps:

1. Put the controller in manual mode, set the output to a nominal 
operating value, and allow the PV to settle completely. Record the
and output values.

2. Make a step change in the output. Record the new output value.

3. Wait for the PV to settle. From the chart, determine the values as 
derived from the sample displayed in Figure 9-2.

The values are as follows: 

• Td—Deadtime in minutes

• T—Time constant in minutes

• K—Process gain = 

Figure 9-2.  Output and Process Variable Strip Chart

change in output
change in PV

----------------------------------------
ComponentWorks Autotuning PID 9-4 © National Instruments Corporation



Chapter 9 Designing Control Strategies

e 

4. Multiply the measured values by the factors shown in Table 9-2, 

and enter the new tuning parameters into your controller. The tabl
provides the proper values for a quarter-decay ratio.

If you want less overshoot, reduce the gain Kc.

Table 9-2.  Open-Loop–Quarter-Decay Ratio Values

Controller PB (percent)
Reset 

(minutes) Rate (minutes)

P — —

PI 3.33Td —

PID 2.00Td 0.50Td

100
KTd

T
----------

110
KTd

T
----------

80
KTd

T
----------
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Error Codes

This appendix lists the error codes returned by ComponentWorks.

Table A-1.  ComponentWorks Errors

Error Code Description

–30000 Unexpected error.

–30002 You have passed an invalid value for one of the 
parameters to the function, method, or property.

–30003 You have passed an invalid type into a parameter of 
Variant type.

–30004 Divide by zero error.

–30005 Result of a calculation is an imaginary number.

–30006 Overflow error.

–30007 Out of memory.

–30008 You have called a function or method requiring a 
ComponentWorks product for which you do not have
a license. For example, you might be using a metho
that is not supported in the base or standard Analysi
package. To upgrade your product, contact National
Instruments.
s Autotuning PID
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Distribution and 
Redistributable Files

This appendix contains information about ComponentWorks Autotunin
PID redistributable files and distributing applications that use 
ComponentWorks controls.

Files
The files in the \Setup\redist  directory of the ComponentWorks CD 
are necessary for distributing applications and programs that use 
ComponentWorks controls. You need to distribute only those files nee
by the controls you are using in your application.

Distribution
When installing an application using ComponentWorks controls on 
another computer, you also must install the necessary control files and
supporting libraries on the target machine. In addition to installing all 
necessary OCX files on a target computer, you must register each of t
files with the operating system. This allows your application to find the
correct OCX file and create the controls.

If your application performs any I/O operations requiring separate driv
software, such as data acquisition or GPIB, you must install and config
the driver software and corresponding hardware on the target computer
more information, consult the hardware documentation for the specific
driver used.

When distributing applications with the ComponentWorks controls, do n
violate the license agreement (section 5) provided with the software. If 
have any questions about the licensing conditions, contact National 
Instruments.
s Autotuning PID
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Automatic Installers
Many programming environments include some form of a setup or 
distribution kit tool. This tool automatically creates an installer for your
application so that you can easily install it on another computer. To 
function successfully, this tool must recognize which control files and 
supporting libraries are required by your application and include these
the installer it creates. The resulting installer also must register the con
on the target machine.

Some of these tools, such as the Visual Basic 5 Setup Wizard, use 
dependency files to determine which libraries are required by an OCX
file. Each of the ComponentWorks OCX files includes a corresponding
dependency file located in the \Windows\System  directory 
(\Windows\System32  for WindowsNT) after you install the 
ComponentWorks software.

Some setup tools might not automatically recognize which files are 
required by an application but provide an option to add additional files
the installer. In this case, verify that all necessary OCX files (correspond
to the controls used in your application) as well as all the DLL and TLB
files from the \redist  directory are included. You also should verify tha
the resulting installer does not copy older versions of a file over a new
version on the target machine.

If your programming environment does not provide a tool or wizard for
building an installer, you may use third-party tools, such as InstallShie
Some programming environments provide simplified or trial versions o
third-party installer creation tools on their installation CDs. 

Manual Installation
If your programming environment does not include a setup or distribut
kit tool, you must build your own installer and perform the installation ta
manually. To install your application on another computer, follow these
steps:

1. Copy the application executable to the target machine.

2. Copy all required ComponentWorks OCX files (corresponding to 
the controls used in your application) to the System directory 
(\Windows\System  for Windows 95 or \Windows\System32  
for WindowsNT) on the target machine.
ComponentWorks Autotuning PID B-2 © National Instruments Corporation
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3. Copy all DLL and TLB files in the \redist  directory to the System 
directory on the target machine.

4. Copy any other DLLs and support files required by your application
the System directory on the target machine.

Some of these files might already be installed on the target machine. I
file on the target machine has an earlier version number than the file in
\redist  directory, copy the newer file to the target machine.

After copying the files to the target machine, you must register all OCX
files with the operating system. To register an OCX file, you need a uti
such as REGSVR32.EXE. You must copy this utility to the target machine t
register the OCX files, but you can delete it after completing the 
installation. Use this utility to register each OCX file with the operating
system, as in the following example.

regsvr32 c:\windows\system\cwpid.ocx

ComponentWorks Evaluation
Once the ComponentWorks OCX files are installed and registered on 
target computer, your application can create the controls as necessar
You or your customer also can use the same OCX files in any compat
development environment as an evaluation version of the controls. 
If desired, you may distribute the ComponentWorks reference files 
(from the \redist  directory) with your application, which provide 
complete documentation of the ComponentWorks controls when used
in evaluation mode.

If you would like to use the ComponentWorks controls as a developme
tool on this target machine, you must purchase another ComponentW
development system. Contact National Instruments to purchase additi
copies of the ComponentWorks software.

Run-Time Licenses
For each copy of your ComponentWorks-based application that you 
distribute, you must have a valid run-time license. A limited number of
run-time licenses are provided with the ComponentWorks developmen
systems. You can purchase additional ComponentWorks run-time licen
from National Instruments. Consult the license agreement (section 5) 
provided with the software for more detailed information. If you have a
questions about the licensing conditions, contact National Instruments
© National Instruments Corporation B-3 ComponentWorks Autotuning PID



Appendix B Distribution and Redistributable Files

 

e 
 

you 

n 
a 

 

le 
st 
ou 
Troubleshooting
Try the following suggestions if you encounter problems after installing
your application on another computer.

The application is not able to find an OCX file or is not able to create 
a control.

• The control file or one of its supporting libraries is not copied on th
computer. Verify that the correct OCX files and all their supporting
libraries are copied on the machine. If one control was built using 
another, you might need multiple OCX files for one control.

• The control is not properly registered on the computer. Make sure 
run the registration utility and that it registers the control.

Controls in the application run in evaluation (demo) mode.

• The application does not contain the correct run-time license. Whe
developing your application, verify that the controls are running in 
fully licensed mode. Although most programming environments 
include a run-time license for the controls in the executable, some
do not.

If you are developing an application in Visual C++ using SDI (sing
document interface) or MDI (multiple document interface), you mu
include the run-time license in the program code for each control y
create. Consult the ComponentWorks documentation, National 
Instruments Knowledgebase (www.natinst.com/support ) or 
technical support if you are not familiar with this operation.
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.
s Autotuning PID
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Québec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________ Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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____
ComponentWorks Hardware and Software 
Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately bef
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
Hardware revision ___________________________________________________________

Interrupt level of hardware _____________________________________________________

DMA channels of hardware ____________________________________________________

Base I/O address of hardware ___________________________________________________

Programming choice _________________________________________________________

National Instruments software __________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards _______________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________

Other Products
Computer make and model ____________________________________________________

Microprocessor ______________________________________________________________

Clock frequency or speed ______________________________________________________

Type of video board installed ___________________________________________________

Operating system version ______________________________________________________

Operating system mode _______________________________________________________

Programming language _______________________________________________________

Programming language version _________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards _______________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________
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Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our pro
This information helps us provide quality products to meet your needs.

Title: Getting Results with ComponentWorks™ Autotuning PID

Edition Date: August 1998

Part Number: 322064A-01

Please comment on the completeness, clarity, and organization of the manual.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

Thank you for your help.

Name _____________________________________________________________________

Title ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

E-Mail Address ______________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) ___________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039
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Prefix Meaning Value

k- kilo- 103

m- milli- 10–3

µ- micro- 10–6

n- nano- 10–9

Symbols

° Degrees.

∞ Infinity. 

Ω Ohms. 

% Percent. 

A

A Amperes.

ActiveX Set of Microsoft technologies for reusable software components. Form
called OLE.

ActiveX control Standard software tool that adds additional functionality to any compat
ActiveX container. The PID, DAQ, and UI tools in ComponentWorks ar
all ActiveX controls. An ActiveX control has properties, methods, objec
and events.

algorithm A prescribed set of well-defined rules or processes for the solution of 
problem in a finite number of steps.

anti-reset windup A method that prevents the integral term of the PID algorithm from mo
too far beyond saturation when an error persists.
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bias The offset added to a controller’s output.

bumpless transfer A process in which the next output always increments from the curre
output, regardless of the current controller output value; therefore, tran
from automatic to manual control is always bumpless.

C

C Celsius.

cascade control Control in which the output of one controller is the setpoint for anoth
controller.

closed loop A signal path which includes a forward path, a feedback path, 
and a summing point and which forms a closed circuit. Also called 
a feedback loop.

collection Control property and object that contains a number of objects of the s
type, such as PID parameters. The type name of the collection is the p
of the type name of the object in the collection. For example, a collect
of CWPIDParameter objects is called CWPIDParameters. To referenc
object in the collection, you must specify the object as part of the collect
usually by index. For example, CWPID.Parameters.Item(2)  is the 
second parameter in the CWPIDParameters collection of the control.

controller output See manipulated variable.

D

damping The progressive reduction or suppression of oscillation in a device 
or system. 

DC Direct current.

dead time (Td) The interval of time, expressed in minutes, between initiation of an inp
change or stimulus and the start of the resulting observable response.

derivative (control) 
action

Control response to the time rate of change of a variable. Also called 
rate action.
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deviation Any departure from a desired value or expected value or pattern.

device Plug-in data acquisition board that can contain multiple channels and
conversion devices.

downstream loop In a cascade, the controller whose setpoint is provided by 
another controller.

driver Software that controls a specific hardware device, such as a data 
acquisition board.

E

EGU Engineering units.

event Object-generated response to some action or change in state, such a
mouse click or x number of points being acquired. The event calls an e
handler (callback function), which processes the event. Events are def
as part of an OLE control object.

exception Error message generated by a control and sent directly to the applica
or programming environment containing the control.

F

FC Flow controller.

feedback control Control in which a measured variable is compared to its desired valu
produce an actuating error signal that is acted upon in such a way as 
reduce the magnitude of the error.

feedback loop See closed loop.

form Window or area on the screen on which you place controls and indica
to create the user interface for your program.
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gain For a linear system or element, the ratio of the magnitude (amplitude)
steady-state sinusoidal output relative to the causal input; the length o
phasor from the origin to a point of the transfer locus in a complex pla
Also called the magnitude ratio.

General Purpose 
Interface Bus (GPIB)

The common name for the communications interface system defined i
ANSI/IEEE Standard 488.1-1987 and ANSI/IEEE Standard 488.2-198

H

Hz Hertz. 

I

Instrument Society of 
America (ISA)

The organization that sets standards for process control instrumentatio
the United States.

integral action rate See reset rate.

integral (control) action Control action in which the output is proportional to the time integral o
input. That is, the rate of change of output is proportional to the input.

I/O Input/output.

K

K Process gain.

Kc Controller gain.

kHz Kilohertz.

L

lag A lowpass filter or integrating response with respect to time.

loop cycle time Time interval between calls to a control algorithm. 
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magnitude ratio See gain.

manipulated variable A quantity or condition that is varied as a function of the actuating er
signal so as to change the value of the directly controlled variable. Als
called controller output.

MB Megabytes of memory.

method Function that performs a specific action on or with an object. The opera
of the method often depends on the values of the object properties.

ms Milliseconds.

N

noise In process instrumentation, an unwanted component of a signal or vari
Noise may be expressed in units of the output or in percent of output s

O

object Software tool for accomplishing tasks in different programming 
environments. An object can have properties, methods, and events. 
You change an object’s state by changing the values of its properties. 
An object’s behavior consists of the operations (methods) that can be 
performed on it and the accompanying state changes.

See property, method, event.

Object Browser Dialog window that displays the available properties and methods for
the controls that are loaded. The object browser shows the hierarchy 
within a group of objects. To activate the object browser in Visual Basi
press <F2>.

OCX OLE Control eXtension. Another name for ActiveX controls, reflected b
the .OCX file extension of ActiveX control files.

OLE Object Linking and Embedding. See ActiveX.

OLE control See ActiveX control.
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output limiting Preventing a controller’s output from travelling beyond a desired maxim
range.

overshoot The maximum excursion beyond the final steady-state value of outpu
the result of an input change. Also called transient overshoot.

P

P Proportional.

P controller A controller which produces proportional control action only; that is, 
a controller that has only a simple gain response.

PC Pressure controller.

PD Proportional, derivative.

PD controller A controller that produces proportional plus derivative (rate) control ac

PI Proportional, integral.

PI controller A controller that produces proportional plus integral (reset) control ac

PID Proportional, integral, derivative.

PID controller A controller that produces proportional plus integral (reset) plus deriva
(rate) control action.

process gain (K) For a linear process, the ratio of the magnitudes of the measured pro
response to that of the manipulated variable.

process variable (PV) The measured variable (such as pressure or temperature) in a proce
be controlled.

property Attribute that controls the appearance or behavior of an object. The 
property can be a specific value or another object with its own propert
and methods. For example, a value property is the setpoint (property)
Ramp (object), while an object property is the Autotune (property) on t
PID (object). Autotune itself is another object with properties, such as no
level and controller type.
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proportional band (PB) The change in input required to produce a full range change in outpu
to proportional control action. PB = 100/Kc

proportional kick The response of a proportional controller to a step change in the setpo
process variable.

Q

Quarter Decay Ratio A response in which the amplitude of each oscillation is one-quarter t
the previous oscillation.

R

ramp The total (transient plus steady-state) time response resulting from a su
increase in the rate of change from zero to some finite value of the inp
stimulus. Also called ramp response.

rate action Control response to the time rate of change of a variable. Also called
derivative control action.

reference Link to an external code source in Visual Basic. References are anyth
that add additional code to your program, such as OLE controls, DLLs
objects, and type libraries. You can add references by selecting the 
Tools»References… menu. 

reset rate Of proportional plus integral or proportional plus integral plus derivati
control action devices: for a step input, the ratio of the initial rate of cha
of output due to integral control action to the change in steady-state ou
due to proportional control action.

Of integral control action devices: for a step input, the ratio of the 
initial rate of change of output to the input change. Also called integral 
action rate.

reverse acting
(increase-decrease) 
controller

A controller in which the value of the output signal decreases as the va
of the input (measured variable) increases.

RPM Revolutions per minute.
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s Seconds.

scope chart Chart indicator modeled on the operation of an oscilloscope.

selector control The use of multiple controllers and/or multiple process variables in w
the connections may change dynamically depending on process condi

setpoint (SP) An input variable that sets the desired value of the controlled proces
variable.

skeleton function Applies a succession of thinning operations to an object until its widt
becomes one pixel.

span The algebraic difference between the upper and lower range values.

strip chart A plotting indicator modeled after a paper strip chart recorder, which 
scrolls as it plots data.

T

time constant (T) In process instrumentation, the value T (in minutes) in an exponentia
response term, A exp (–t/T), or in one of the transform factors, such 
as 1+sT.

transient overshoot See overshoot. 

V

V Volts.

valve dead band In process instrumentation, the range through which an input signal m
varied, upon reversal of direction, without initiating an observable chan
in output signal.

W

While Loop Post-iterative-test loop structure that repeats a section of code until a 
condition is met. Comparable to a Do loop or a Repeat-Until loop in 
conventional programming languages.
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A
ActiveX controls, 1-1. See also controls.
algorithms

autotuning algorithm, 8-5 to 8-7
PID algorithm, 8-1 to 8-5

anti-windup transfers, 8-4
application development

Delphi, 5-1 to 5-7
building user interface, 5-3 to 5-5
editing properties 

programmatically, 5-6
events, 5-7
loading ComponentWorks controls into 

palette, 5-2 to 5-3
methods, 5-7
programming with ComponentWorks, 

5-6 to 5-7
running examples, 5-1

getting started, 2-3 to 2-5
Visual Basic, 3-1 to 3-9

automatic code completion, 3-9
building user interface, 3-2 to 3-5
developing event routines, 3-5 to 3-6
loading ComponentWorks controls into 

toolbox, 3-2
pasting code into programs, 3-8 to 3-9
procedure overview, 3-1
using Object Browser, 3-6 to 3-8
working with methods, 3-5

Visual C++, 4-1 to 4-9
adding ComponentWorks controls to 

toolbar, 4-3 to 4-4
building user interface, 4-4 to 4-5
events, 4-8 to 4-9
methods, 4-8
MFC AppWizard, 4-2 to 4-3
procedure overview, 4-1

programming with ComponentWorks 
controls, 4-5 to 4-6

properties, 4-6 to 4-8
Application Wizard, MFC, 4-2 to 4-3
automatic code completion, in Visual Basic, 3-
Autotune object, 6-3
AutotunePID example, 7-1
Autotune Wizard, 6-4
autotuning algorithm, 8-5 to 8-7. See also tuning.

setpoint relay experiment (figure), 8-5
tuning formulas, 8-5 to 8-6

autotuning PID parameters, 6-8 to 6-9

B
bulletin board support, C-1
bumpless transfers, 8-4

C
C++. See Visual C++.
Cascade and Selector example, 7-1
closed-loop (ultimate gain) tuning 

procedure, 9-3
code completion, automatic, in Visual Basic, 3-
collection objects, 1-6
ComponentWorks Autotuning PID. 

See also PID control.
components, 1-2
examples structure, 2-3
exploring documentation, 2-1 to 2-3
getting started, 2-1 to 2-6
installing, 1-3 to 1-4
online reference, 2-2 to 2-3
overview, 1-1 to 1-2
sources for additional information, 

2-5 to 2-6
system requirements, 1-2 to 1-3
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Index
ComponentWorks Support Web Site, 
2-5 to 2-6

compressor (Cascade and Selector) 
example, 7-1

control strategy design, 9-1 to 9-5
closed-loop (ultimate gain) tuning 

procedure, 9-3
control flowchart (figure), 9-1
manual tuning techniques, 9-2
open-loop (step test) tuning procedure, 

9-4 to 9-5
setting timing, 9-2

controller output value, 1-1
controls, 1-4 to 1-6. See also events; methods; 

PID control; properties.
collection objects, 1-6
LeadLag control, 6-4
loading into programming environments

Delphi, 5-2 to 5-3
Visual Basic, 3-2
Visual C++, 4-3 to 4-4

object hierarchy, 1-5 to 1-6
properties, methods, and events, 

1-4 to 1-5
Ramp control, 6-5

custom property page
definition, 1-8
example (figure), 1-8

customer communication, xv, C-1 to C-2

D
Delphi, 5-1 to 5-7

building user interface, 5-3 to 5-5
editing properties programmatically, 5-6
events, 5-7
loading ComponentWorks controls into 

palette, 5-2 to 5-3
methods, 5-7
newest version of Delphi required 

(note), 5-1

programming with ComponentWorks, 
5-6 to 5-7

running examples, 5-1
designing control strategies. 

See control strategy design.
developing applications. 

See application development.
distribution and redistribution files, B-1 to B-4

ComponentWorks evaluation, B-3
distribution procedure, B-1 to B-3

automatic installers, B-2
manual installation, B-2 to B-3

files required, B-1
running on target computer, B-3
run-time licenses, B-3
troubleshooting, B-4

documentation. See also online reference.
conventions used in manual, xiii-xiv
exploring, 2-1 to 2-3
organization of manual, xi-xiii
related documentation, xiv

E
electronic support services, C-1 to C-2
e-mail support, C-2
error codes, A-1
event handler routines, developing

Delphi, 5-7
overview, 1-11
Visual Basic applications, 3-5 to 3-6
Visual C++ applications, 4-8 to 4-9

events
definition, 1-5
learning about, 1-11
PID control, 6-4

examples
AutotunePID, 7-1
becoming familiar with, 2-3
Cascade and Selector, 7-1
General PID, 7-2
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LeadLag, 7-2
location of examples, 2-3
PID with MIO board, 7-2 to 7-3
RampDemo, 7-3
Tank Level, 7-3

F
fax and telephone support numbers, C-2
Fax-on-Demand support, C-2
files installed on hard disk, 1-4
FTP support, C-1

G
gain scheduling, 8-4 to 8-5
General PID example, 7-2

H
help. See online reference.

I
installation, 1-3 to 1-4

Administrator privileges required 
(note), 1-3

distribution and redistribution files, 
B-2 to B-3

files installed on hard disk, 1-4
from floppy disks, 1-3

integral sum correction algorithm, 8-4
Item method, for setting properties, 1-10

L
LeadLag control, 6-4
LeadLag example, 7-2

M
manual. See documentation.
manual tuning techniques, 9-2. See also 

autotuning algorithm; tuning.
methods

definition, 1-4
learning about, 1-11
setting properties, 1-10
working with control methods

Delphi, 5-7
overview, 1-10
Visual Basic, 3-5
Visual C++, 4-8

Microsoft Foundation Classes Application 
(MFC) Wizard, 4-2 to 4-3

MIO board example, 7-2 to 7-3

O
Object Browser, in Visual Basic, 3-6 to 3-8
object hierarchy

example (figure), 1-6
overview, 1-5
PID control (figure), 6-1

objects
Autotune object, 6-3
collection objects, 1-6
Parameter object, 6-3
PID object, 6-2

OLE (Object Linking and Embedding) 
controls, 1-1. See also controls.

online reference
accessing, 1-1, 1-11, 2-2
finding specific information, 2-2 to 2-3
learning about properties, methods, and

events, 1-11
overview, 2-2
searching complete text, 2-5
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1

open-loop (step test) tuning procedure, 
9-4 to 9-5

open-loop–quarter-decay ratio values 
(table), 9-5

output and process variable strip chart 
(figure), 9-4

procedure, 9-4 to 9-5

P
Parameter object, 6-3
Parameters collection, 6-2
pasting code, in Visual Basic, 3-8 to 3-9
PID algorithm, 8-1 to 8-5

controller output, 8-3
error calculation, 8-2
gain scheduling, 8-4 to 8-5
integral sum correction algorithm, 8-4
nonlinear adjustment of integral 

action, 8-3
output limiting, 8-4
partial derivative action, 8-3
proportional action, 8-2
PV filtering, 8-2
trapezoidal integration, 8-3
Two Degree of Freedom PID 

algorithm, 8-2
PID control, 6-1 to 6-5

Autotune object, 6-3
Autotune Wizard, 6-4
events, 6-4
object hierarchy (figure), 6-1
overview, 1-1
Parameter object, 6-3
Parameters collection, 6-2

PID control tutorial, 6-5 to 6-9
autotuning PID parameters, 6-8 to 6-9
developing PID system, 6-5 to 6-8

code development, 6-7
form design, 6-5 to 6-6
setting PID properties, 6-6
testing your program, 6-8

PID examples, 7-1 to 7-3
AutotunePID, 7-1
Cascade and Selector, 7-1
General PID, 7-2
LeadLag, 7-2
PID with MIO board, 7-2 to 7-3
RampDemo, 7-3
Tank Level, 7-3

PID object, 6-2
Plant Simulator subroutine, 7-3
process variable, 1-1
properties

definition, 1-4
editing programmatically

Delphi, 5-6
overview, 1-9
Visual Basic, 3-4 to 3-5

learning about, 1-11
setting, 1-7 to 1-11

developing event handler 
routines, 1-11

Item method, 1-10
using property pages, 1-7 to 1-8
working with methods, 1-10

using in programming environments
Delphi, 5-4 to 5-5
Visual Basic, 3-3 to 3-5
Visual C++, 4-6 to 4-8

property pages
custom property page

definition, 1-8
example (figure), 1-8

setting properties for controls, 1-7 to 1-1
Visual Basic default property sheets 

(figure), 1-8
proportional band, 8-1
Proportional-Integral-Derivative control. 

See PID control.
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Q
Quarter-Decay Ratio tuning technique, 9-2

R
Ramp control, 6-5
RampDemo example, 7-3
rate time, 8-1
redistribution files. 

See distribution and redistribution files.
requirements for getting started, 1-2 to 1-3
reset time, 8-1
run-time licenses, B-3

S
Selector and Cascade example, 7-1
setpoint, 1-1
software object, 1-5
step test (open-loop) tuning procedure, 

9-4 to 9-5
system requirements, 1-2 to 1-3

T
Tank Level example, 7-3
technical support, C-1 to C-2
telephone and fax support numbers, C-2
timing of controls, setting, 9-2
troubleshooting distribution and redistribution 

files, B-4
tuning. See also autotuning algorithm.

closed-loop (ultimate gain) tuning 
procedure, 9-3

manual tuning technique, 9-2
open-loop (step test) tuning procedure, 

9-4 to 9-5
Two Degree of Freedom PID algorithm, 8-2

U
ultimate gain (closed-loop) tuning 

procedure, 9-3

user interface, building
Delphi applications, 5-3 to 5-5

placing controls, 5-4
using property pages, 5-4 to 5-5

Visual Basic applications, 3-2 to 3-5
editing properties programmatically, 

3-4 to 3-5
using property pages, 3-3 to 3-4

Visual C++ applications, 4-4 to 4-5

V
Visual Basic, 3-1 to 3-9

automatic code completion, 3-9
building user interface, 3-2 to 3-5

editing properties programmatically, 
3-4 to 3-5

using property pages, 3-3 to 3-4
default property sheets (figure), 1-8
developing event routines, 3-5 to 3-6
loading ComponentWorks controls into 

toolbox, 3-2
pasting code into programs, 3-8 to 3-9
procedure overview, 3-1
using Object Browser, 3-6 to 3-8
working with methods, 3-5

Visual C++, 4-1 to 4-9
adding ComponentWorks controls to 

toolbar, 4-3 to 4-4
building user interface, 4-4 to 4-5
events, 4-8 to 4-9
methods, 4-8
MFC AppWizard, 4-2 to 4-3
procedure overview, 4-1
programming with ComponentWorks 

controls, 4-5 to 4-6
properties, 4-6 to 4-8

W
Web site for ComponentWorks support, 

2-5 to 2-6
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